y 4
hilscher

COMPETENCE IN
COMMUNICATION

User Manual

SmartWire-DT Gateway
EU5C-SWD-POWERLINK

Hilscher Gesellschaft fur Systemautomation mbH
www.hilscher.com

DOC130802UMO4EN | Revision 4 | English | 2015-06 | Released | Public



Table of contents 2/81

Table of contents

I 1117 o T L ¥ o o PP 5
1.1 ADOUL thiS OCUMENT. ... .t eensssnnesnnennnes 5
1.1.1 Description of the contents................ccc . 5

1.1.2 LiSt Of FEVISIONS ....eeiiie e e e e 5

1.1.3 Conventions in this dOCUMENT ........cooiiiiiiiiii 6

1.2 Versions of devices, firmware, software tools and drivers ...........ccccoccoieeiiieiieiiiciiiieee. 7

1.3 SOfWAIrE PACKAGE .. et nnnnrnnne 8
1.3.1 OVEIVIBW ...ttt ettt e e e e e e ettt e e e e e e e s s b e e eeeaeeeeennnnnneeees 8

1.3.2 Contents of the producCt DVD.........cooiiiiiiiiic e 8

1.3.3 How to use the product DVD ..., 10

1.3.4 Notes on installing the USB DIiVEr ... 11

1.4 DoCUMENTAtION OVEIVIEW ......uiiii s sssssnssnnnsnne 12

RS =T b= I 0T ] =Y SO 13
1.5.1 (O] )Y/ [« | | SRR 13

1.5.2 IMPOrtaNt NOLES .. ..o e 13

1.5.3 Exclusion of liability ..........coooiiiiii 14

1.5.4 LAY = T =1 1 2SR 14

1.5.5 EXPOrt reguIatioNS.........oeeeeeeeeee s 15

1.5.6 Registered Trademarks ... 15

7 T | -1 7 16
0 B € 1= 1= = | N T ] (= SR 16

D | 01 =Y g T =Y 0T SRR 16

2.3 Personnel QUAlIfICAtioN ..........oooiiiiiiiie s 16

2.4 REErENCES SATELY ...uiuuiiiiiiiiiiiiiiii ettt e e eeeeeeaseessaessaessassessssessseessseseeeseeeeenes 16

2.5 Safety instructions to avoid personal iNJUIY ... 17
2.5.1 Electrical shock hazard............ccco 17

252 Danger of unintended starting up of machines........................ccooo, 17

2.6  Safety instructions to avoid property damage ...........coooouiiiiiiiiiiiiii e 18
2.6.1 General safety instructions concerning supply voltage ...........ccccccccc. 18

2.6.2 Device destruction by exceeding allowed supply voltage....................oeeeeen. 18

2.6.3 Electrostatic sensitive deviCe............oooiii 19

2.7 Labeling of safety MESSAGES ... ..uuuuuiiiiiiiiiiiiiiiiieiiieiieee ettt eee e e e e e e e eeeeeeeeeeeeeeeeeeees 20

3 Device description EUSC-SWD-POWERLINK gateway .........cccccceiiiriiiniinniissiinnssnsnssssssnnnnns 21
K Tt B ¥ [ (o1 1o o F PSPPSR 21

I O70 ) 1o 01 = 1110 o HU PRSP PPPPPPPPPP 22

TR T [ 0] (=T o = oY= SRR 23

K I 1= | [ 1 - SRR 23

3.5 Firmware and device description file ............oovviiiiiiiiiiiiiiieeieeeeeeeeeeeeeeeeeeeeeeeeeeeeee e 24

4 Requirements for Operation ... 25
4.1 NEtWOIK SYSEMIS ..ot e e e e e e e e e e e e e e 25

4.2 POWET SUPPIY e 25
4.2.1 POW power connection ... 26

4.2.2 AUX POWET CONNECHION ... eanssnnsnnnnnnes 26

5 Device picture, connectors and LEDS ...........cccooiiiiimciiiiiiirrrrceecr s s e e s e 27
SmartWire-DT Gateway | EU5C-SWD-POWERLINK © Hilscher 2013 — 2015

DOC130802UMO4EN | Revision 4 | English | 2015-06 | Released | Public



Table of contents 3/81

T B B 1=V (ot Y o] o1 (1] = TP 27

5.2 Positions and meaning of the LEDS ..........oooiiiiiiiiiiiiiiieieeeeeeeeeeeeeeeeeeeeeeeeeeeeeeee e 28
5.2.1 Positions of the LEDS .....coooeiiiei 28

5.2.2 Descriptions of the LEDS ..o 29

5.3 Pinning of the Real-Time Ethernet interface ............cccviiiiiiiiiii e 31

5.4  DeVIiCe tYPE IADEL ... .o ——— 32

6  Getting Started ... nnn s 33
7 Installing gateway ... ————————————— 34
A S T 1 (=Y AV 0 0 (=TT Lo LT SRR 34

A Y/ (018 a1 (T Yo o =1 (== PP 35
7.2.1 Mounting gateway onto top hat rail............coooeviiii e, 35

7.2.2 Removing gateway from top hat rail ... 37

7.3  Connecting gateway t0 POWET SUPPIY ..ceviiiiiiiiiiiiiieiiieeeeee ettt e e e e e 38

7.4 Connecting SMartWire-DT ... 40

7.5 Connecting POWERLINK .....oooiiiiiieeiiieeeeeeee ettt e e e e e e e e e e e e e e e eeeeeeeees 41

7.6 EMC-conformant wiring of the NetWork ... 41

8 Configuring gatewWay .........cccccceimiiiiiirr s —————————————————— 42
8.1  Configuring SmartWire-DT network in gateway (creating target configuration) ............. 42

8.2 Installing SWD-Assist and USB driver on configuration PC.............cccccoiiiiiiinnns 44

8.3 Connecting gateway to configuration PC via USB ..., 46

8.4  Configuring gateway in SWD-Assist (creating project configuration) ............................. 47

9 Configuring gateway in POWERLINK ... s 52
10 POWERLINK data communiCatioN...........ooeemmmimmmimeieieeeeeeeeeeeeeeeeeeee e e e e s e e s e e s e ene e ennes 56
10.1  Acyclical COMMUNICALION ........i e asnnnanes 56
10.1.1  SDO Write (aCYCliC OULPUL) ....ceviiiiiiiiiieeiie e 56

10.1.2 SDO Read (aCYCliC INPUL) ....veiiiieeeeieiiiee e 58

10.2 Error Entry: Error and status messages (diagnosSis) ............uuuveieueimmiiimiiiiiiiiiiiiiineiinninnnns 59
1021 OVEIVIEW ..o 59

10.2.2 Error messages (diagnosis) of individual SWD slaves.............ccccccoeeeieennnenn. 61

10.2.3 SWD bus error and status messages generated by the gateway .................. 63

11 Updating fIrMWAIE .......eeeeeeeeeeeeeeeceieeeceeeeeeeeeeeeeeeeeneennn e e e nennnasseessenssnsnsssnnsssrsnnnsnnsnnnnnnnnnnnnnnnnnnns 65
I PR B O Y T 65
11.2  |P AAress Of GAtEWAY ........cooiiiiiiiiiiiiieie e 66
T1.3 Prer@qUISITES ... it e e e e e e e e e e e e e e e e e e e e e aeas 67
11.4 Step-by-step instructions for updating firmware .............cccccoviiis 67
11.5 ReESEtliNG GAtEWAY ..covvviiiii i e e e 69

12 Firmware recovery VIa HTTP ...ttt s s e s s s s e e s e s s s s s e s e e nmmm e s e e 70
P2 B O Y T 70
L o = (=T o [ 1] 1= 70
12.3  Step-by-Step INSIrUCHIONS ... . e 71

13 Technical data...... .. eeceeec e nceenceeenemmeemneesneensenmnnnnnnnnennnnnnnsnnnnnnnnnnnnnnnnnnn 75
13.1 Technical data EUSC-SWD-POWERLINK gateway............ccccccuvurrmmiimniiiriiiiiiiiiiiniinnnnnnns 75
SmartWire-DT Gateway | EU5C-SWD-POWERLINK © Hilscher 2013 — 2015

DOC130802UMO4EN | Revision 4 | English | 2015-06 | Released | Public



Table of contents 4/81

13.2 POWERLINK ...ttt et e e e e e e e et e e e e e e e e e era b e e eeaeeas 78
LisSt Of fIQUIES .....ceeeiiiiiceiir e 79
T3 A o - o] = 80
[0 o 41 - T3 - 81
SmartWire-DT Gateway | EU5C-SWD-POWERLINK © Hilscher 2013 — 2015

DOC130802UMO4EN | Revision 4 | English | 2015-06 | Released | Public



Introduction 5/81

1 Introduction

1.1 About this document

1.1.1 Description of the contents

This manual describes the Hilscher EUSC-SWD-POWERLINK
SmartWire-DT Gateway. Here you will find information on how to install,
configure and operate the gateway.

This manual is intended for automation technicians and engineers. Detailed
knowledge of Ethernet POWERLINK is presumed. In addition, readers
should also be familiar with the handling of the SmartWire-DT system.

Important:

» To avoid personal injuries or damage of electrical devices,
please read this manual carefully before installing and using the
EU5C-SWD-POWERLINK Gateway.

> Please first read chapter Safety [ page 16].

1.1.2 List of revisions

Revision |Date Revisions

1 2013-10-15 Created

2 2013-12-09 Section Diagnosis/Status Response revised.
3 2014-11-05 Chapter Firmware Recovery via HTTP added.

Section Software Package updated.

Description of POW LED in section Descriptions of the LEDs
updated.

Section Contacts updated.
Safety symbols revised according to ANSI.
4 2015-06-26 Design of safety messages updated.

Section Diagnosis/Status response revised and renamed as
Error Entry: Error and status messages (diagnosis) [ page
59].

Table 1: List of revisions

SmartWire-DT Gateway | EU5C-SWD-POWERLINK © Hilscher 2013 — 2015
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1.1.3 Conventions in this document

Notes, operation instructions and results of operation steps are marked as
follows:

Notes

o Note:
<important note>

Note:
<simple note>

<note, where to find further information>

Operation instructions

1. <operational step>
» <instruction>

2. <operational step>

» <instruction>
Results

= <intermediate result>

= <final result>

For a description of the labeling of Safety Messages, see section Labeling
of safety messages [ page 20].

SmartWire-DT Gateway | EU5C-SWD-POWERLINK © Hilscher 2013 — 2015
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1.2 Versions of devices, firmware, software tools and drivers

The hardware revisions and software versions functionally belong together.
This means that certain revisions of the hardware of the gateway need
certain versions of firmware, software and drivers, in order to function
properly.

This section lists the hardware revisions and the versions of the firmware,
the configuration software and the drivers which functionally belong
together and to which all instructions in this manual refer.

Device and firmware

This manual refers to the following hardware revision and firmware version
of the EUSC-SWD-POWERLINK Gateway:

Device type name Protocol Part number |Hardware [Firmware Firmware
revision version
EU5C-SWD-POWERLINK POWERLINK 9233.921 3 E030KO0UO.nxf 1.0.x.X
Controlled Node
Table 2: Reference to hardware and firmware
Software tools
This manual refers to the following software versions:
Software Manufacturer Version
Ethernet Device Configuration Tool Hilscher 1.501
Automation Studio Bernecker + Rainer 3.0.90
SWD-Assist Eaton 1.90
Table 3: Reference to software tools
Drivers
This manual refers to the following driver versions:
Driver File name Version

USB-Treiber fir Windows Depending on Windows

version

usbser.sys

Table 4: Reference to drivers

SmartWire-DT Gateway | EU5C-SWD-POWERLINK

© Hilscher 2013 — 2015
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1.3 Software package

1.3.1 Overview

You need the SWD-Assist software in order to configure the EUSC-SWD-
POWERLINK gateway.

The software can be ordered separately from Hilscher under the product
name EU5C-SWD-SW (order number 3233.920). The package contains the
SmartWire-DT Gateway Solutions product DVD and a Mini-USB cable.

You can download the contents of the product DVD as ZIP file free of

charge from our website www.hilscher.com > under Products > Partner
Products > SmartWire-DT > EU5C-SWD-POWERLINK > Downloads >
Software.

1.3.2 Contents of the product DVD

The SmartWire-DT Gateway Solutions product DVD contains software for
all types of SmartWire-DT gateways. Depending on the gateway type you
are using, you will need only certain features of the DVD.

The product DVD includes:
e Device description files

) Note:

. A device description file for the EU5C-SWD-POWERLINK Gateway
is not provided on the product DVD. The project-specific XDD
device description file for the POWERLINK-Gateway has to be
generated by the SWD-Assist software.

e Firmware
e Eaton SWD-Assist software

e Wizard for installing the software available on the DVD and for
downloading the latest version of the SWD-Assist software from the
internet

¢ Installation program for USB driver (USB driver is needed for
connecting the gateway to a PC in order to use the Eaton SWD-Assist
software)

e Installation program for the Hilscher Ethernet Device Configuration Tool
o Documentation in PDF format
¢ Installation program for Adobe Reader

SmartWire-DT Gateway | EU5C-SWD-POWERLINK © Hilscher 2013 — 2015
DOC130802UMO4EN | Revision 4 | English | 2015-06 | Released | Public
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The product DVD has the following directories:

Directory Contents

Documentation PDF manuals in German and English and installation program for Adobe Reader

EDS Electronic device description files and bitmaps, to be imported directly into Master/
Controller configuration software.
Note: The device description file for the EU5C-SWD-POWERLINK Gateway has to be
generated by the SWD-Assist software.

Firmware Loadable gateway firmware

fscommand Files for start screen of product DVD

Setups & Drivers

SWD-Assist software
Folder: SWD-Assist

Wizard for installing the software available on the DVD and for downloading the latest
version of the SWD-Assist software from the internet
Folder: setup

Installation program for Ethernet Device Configuration Tool
Folder: EnDeviceCfg

Installation program (setup.exe) and .INF- and .CAT- files for Windows USB driver.
Folder: USB Driver

Table 5: Directory of the product DVD

9 Note:
. You can use the wizard on the product DVD to download updates of

the Eaton SWD-Assist software, or you can download SWD-Assist
directly from the www.moeller.net website under Support >
Download Center. Direct link:
http://downloadcenter.moeller.net/en/software.a487d8b7-
da91-486f-b3ba-a7ca2035db99

SmartWire-DT Gateway | EU5C-SWD-POWERLINK © Hilscher 2013 — 2015
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1.3.3 How to use the product DVD

Insert the SmartWire-DT Gateway Solutions product DVD into the DVD
drive of your configuration PC.

If the auto start function of your DVD drive is enabled, the start screen of
the DVD automatically opens. You can also start the DVD by double-
clicking the smartWire.exe file in the root directory of the DVD.

In the menu of the start screen of the DVD, click Install Planning and
Configuration Tools to open a wizard for installing the software programs
stored on the DVD. The wizard also helps you to download the latest
version of the Eaton planning software SWD-Assist from the internet. It
automatically checks for already installed software components (which e. g.
might have been installed for an earlier project), and lists the missing
components accordingly. The following options might be offered:

e USB Driver: installs USB driver for Windows on your PC.

¢ Download Center SWD-Assist (manual update): connects your
browser to a web page where you can download the latest version of
the SWD-Assist software.

e SWD Planning Software SWD-Assist Vx.xx: installs the SWD-Assist
software version provided on the DVD.

o Ethernet Device Scanner/Configuration Tool: installs the Hilscher
Ethernet Device Configuration Tool.

e GSDML, EDS, ESI files (HTML page): opens a web page containing
links to the device description files.

9 Note:

. A device description file for the EU5C-SWD-POWERLINK Gateway
is not provided on the product DVD. The project-specific XDD
device description file for the POWERLINK-Gateway has to be
generated by the SWD-Assist software.

In the main menu of the start screen of the DVD, you can furthermore open
a web page which provides an overview of all available documents (menu
Documentation). You can also directly open the folder containing the
device description files (menu Open Electronic Device Description Files
Directory).

SmartWire-DT Gateway | EU5C-SWD-POWERLINK © Hilscher 2013 — 2015
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1.3.4

Notes on installing the USB Driver

If you intend to use the SWD-Assist software, you should first install the
USB driver on your PC before you connect the gateway via USB.

To install the USB driver from the DVD, choose Install Planning and
Configuration Tools in the DVD menu to open the installation wizard, and
then select the USB driver option. As an alternative, you can use the
Windows Explorer to open the Setups & Drivers\USB Driver folder on
the DVD, and then double-click the setup.exe file. Just follow the
instructions of the installation routine afterwards.

) Note:

. Under Windows XP, the installation process is not yet finished by
the setup. The installation process has to be completed in the
Found new Hardware Wizard, which automatically opens when
you connect the gateway to a PC via USB cable for the first time
(see below).

Windows XP

When you connect the gateway via USB for the first time to a PC running
under Windows XP, the Found New Hardware Wizard opens:

» Answer the question Can Windows connect to Windows Update...?,
with No, not this time. Then click Next button.

» If you have already carried out the setup of the USB driver (as
recommended), you can ignore the wizard’s request to insert a CD or
floppy disk. Answer the What do you want the wizard to do? question
by selecting the Install the software automatically option, then click
Next button.

» After the installation is complete, click Finish button.

Windows 7 and 8

The USB connection is instantly operative under Windows 7 and 8 if you
have carried out the setup of the USB driver before first connecting the
USB cable (as recommended).

Uninstall USB Driver

If you want to remove the USB driver from a PC running under Windows
XP, choose Start menu > Control Panel > Add or Remove Programs,
then select:

Windows Driver Package — Hilscher GmbH (hilusbser) Ports entry.
Click Change/Remove button to uninstall the driver.

Under Windows 7 and 8, choose Start menu > Control Panel > Uninstall
a program, then select:

Windows Driver Package — Hilscher GmbH (hilusbser) Ports entry.
Click Uninstall/Change button to uninstall the driver.

SmartWire-DT Gateway | EU5C-SWD-POWERLINK © Hilscher 2013 — 2015
DOC130802UMO4EN | Revision 4 | English | 2015-06 | Released | Public
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1.4 Documentation overview

Besides this user manual at hand (path on product DVD: Documentation
\english\2. Hardware\EU5C-SWD-POWERLINK UM xx EN.pdf), the
following documents are also relevant for the user of the EU5C-SWD-
POWERLINK gateway:

Title Contents Publisher Document ID Path on product DVD
SmartWire-DT Information on Eaton MNO05006001Z-EN Documentation\english\
Units engineering, installation 3.SmartWire-DT\SmartWire-DT —
and programming of the Units\
individual SmartWire-DT MNO05006001Z_EN.pdf
slaves.
SmartWire-DT Information on function, |[Eaton MNO05006002Z-EN Documentation\english\
The System installation, 3.SmartWire-DT\SmartWire-DT -
commissioning and The System\
diagnostics of the MNO05006002Z_EN.pdf
SmartWire-DT system.
Ethernet Device |Operating Instruction Hilscher DOCO0504020IxxEN [ Documentation\english\
Configuration Manual of Hilscher 1.Software\Ethernet Device Setup
Ethernet Device Utility\
Configuration Tool. Ethernet Device Configuration Ol
xx EN.pdf
SWD-Assist Online help for SWD- Eaton - Included in SWD-Assist software
Online help Assist planning software
B&R Help Online help for Bernecker + |- Included in Automation Studio
Explorer — Automation Studio Rainer software
Automation software
Studio

Table 6: Documentation overview

SmartWire-DT Gateway | EU5C-SWD-POWERLINK
DOC130802UMO4EN | Revision 4 | English | 2015-06 | Released | Public
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1.5 Legal notes

1.5.1 Copyright
© Hilscher 2013 - 2015, Hilscher Gesellschaft fur Systemautomation mbH
All rights reserved.

The images, photographs and texts in the accompanying material (user
manual, accompanying texts, documentation, etc.) are protected by
German and international copyright law as well as international trade and
protection provisions. You are not authorized to duplicate these in whole or
in part using technical or mechanical methods (printing, photocopying or
other methods), to manipulate or transfer using electronic systems without
prior written consent. You are not permitted to make changes to copyright
notices, markings, trademarks or ownership declarations. The included
diagrams do not take the patent situation into account. The company
names and product descriptions included in this document may be
trademarks or brands of the respective owners and may be trademarked or
patented. Any form of further use requires the explicit consent of the
respective rights owner.

1.5.2 Important notes

The user manual, accompanying texts and the documentation were created
for the use of the products by qualified experts, however, errors cannot be
ruled out. For this reason, no guarantee can be made and neither juristic
responsibility for erroneous information nor any liability can be assumed.
Descriptions, accompanying texts and documentation included in the user
manual do not present a guarantee nor any information about proper use
as stipulated in the contract or a warranted feature. It cannot be ruled out
that the user manual, the accompanying texts and the documentation do
not correspond exactly to the described features, standards or other data of
the delivered product. No warranty or guarantee regarding the correctness
or accuracy of the information is assumed.

We reserve the right to change our products and their specification as well
as related user manuals, accompanying texts and documentation at all
times and without advance notice, without obligation to report the change.
Changes will be included in future manuals and do not constitute any
obligations. There is no entitlement to revisions of delivered documents.
The manual delivered with the product applies.

Hilscher Gesellschaft flir Systemautomation mbH is not liable under any
circumstances for direct, indirect, incidental or follow-on damage or loss of
earnings resulting from the use of the information contained in this
publication.

SmartWire-DT Gateway | EU5C-SWD-POWERLINK © Hilscher 2013 — 2015
DOC130802UMO4EN | Revision 4 | English | 2015-06 | Released | Public
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1.5.3 Exclusion of liability

The software was produced and tested with utmost care by Hilscher
Gesellschaft fir Systemautomation mbH and is made available as is. No
warranty can be assumed for the performance and flawlessness of the
software for all usage conditions and cases and for the results produced
when utilized by the user. Liability for any damages that may result from the
use of the hardware or software or related documents, is limited to cases of
intent or grossly negligent violation of significant contractual obligations.
Indemnity claims for the violation of significant contractual obligations are
limited to damages that are foreseeable and typical for this type of contract.

It is strictly prohibited to use the software in the following areas:
e for military purposes or in weapon systems;

o for the design, construction, maintenance or operation of nuclear
facilities;

e in air traffic control systems, air traffic or air traffic communication
systems;

e in life support systems;

e in systems in which failures in the software could lead to personal injury
or injuries leading to death.

We inform you that the software was not developed for use in dangerous
environments requiring fail-proof control mechanisms. Use of the software
in such an environment occurs at your own risk. No liability is assumed for
damages or losses due to unauthorized use.

1.5.4 Warranty

Although the hardware and software was developed with utmost care and
tested intensively, Hilscher Gesellschaft flr Systemautomation mbH does
not guarantee its suitability for any purpose not confirmed in writing. It
cannot be guaranteed that the hardware and software will meet your
requirements, that the use of the software operates without interruption and
that the software is free of errors. No guarantee is made regarding
infringements, violations of patents, rights of ownership or the freedom from
interference by third parties. No additional guarantees or assurances are
made regarding marketability, freedom of defect of title, integration or
usability for certain purposes unless they are required in accordance with
the law and cannot be limited. Warranty claims are limited to the right to
claim rectification.

SmartWire-DT Gateway | EU5C-SWD-POWERLINK © Hilscher 2013 — 2015
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1.5.5 Export regulations

The delivered product (including the technical data) is subject to export or
import laws as well as the associated regulations of different counters, in
particular those of Germany and the USA. The software may not be
exported to countries where this is prohibited by the United States Export
Administration Act and its additional provisions. You are obligated to
comply with the regulations at your personal responsibility. We wish to
inform you that you may require permission from state authorities to export,
re-export or import the product.

1.5.6 Registered Trademarks

Adobe Reader® is a registered trademark of Adobe Systems Incorporated.

Ethernet POWERLINK and B & R Automation Studio are trademarks of
B&R, Bernecker + Rainer Industrie-Elektronik Ges.m.b.H, Eggelsberg,
Austria.

SmartWire-DT® is a registered trademark of Eaton Corporation.

Windows® XP, Windows® 7 and Windows® 8 are registered trademarks of
the Microsoft Corporation.

All other mentioned trademarks are property of their respective legal
owners.

SmartWire-DT Gateway | EU5C-SWD-POWERLINK © Hilscher 2013 — 2015
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2 Safety

2.1 General note

The user manual, all accompanying texts and the documentation are
written for the use of the products by educated personnel. When using the
products, all safety instructions, property damage messages and all valid
legal regulations have to be observed. Technical knowledge is presumed.
The user has to assure that all legal regulations are obeyed.

2.2 Intended use

The purpose of the EUSC-SWD-POWERLINK Gateway described in this
user manual is to create a connection between SmartWire-DT slaves and
an overriding Managing Node (master device) in an Ethernet POWERLINK
network.

2.3 Personnel qualification

The gateway must be installed, configured and removed by qualified
personnel only. Job-specific technical skills for people professionally
working with electricity must be present concerning the following issues:

e Safety and health at work

¢ Mounting and connecting of electrical equipment

o Measurement and analysis of electrical functions and systems
e Evaluation of the safety of electrical systems and equipment

e |Installing and configuring IT systems

2.4 References safety

[S1] ANSI Z535.6-2006 American National Standard for Product Safety Information in
Product Manuals, Instructions, and Other Collateral Materials

[S2] IEC 60950-1, Information technology equipment - Safety -
Part 1: General requirements,
(IEC 60950-1:2005, modified); German Edition EN 60950-1:2006

[S3] EN61340-5-1 and EN 61340-5-2 as well as IEC 61340-5-1 and IEC 61340-5-2

SmartWire-DT Gateway | EU5C-SWD-POWERLINK © Hilscher 2013 — 2015
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2.5 Safety instructions to avoid personal injury

To ensure your own personal safety and to avoid personal injury, you must
read, understand and follow the following safety instructions in this manual
and all warning messages before you install and operate the gateway.

251 Electrical shock hazard

Take care of the following safety measures before installing or uninstalling
the gateway:

e First disconnect the power plug of the device.
e Make sure that the device is disconnected from the power supply.
e Cover or enclose neighboring units that are live.

Devices that are designed for mounting in housings or control cabinets
must only be operated and controlled after they have been installed with
the housing closed. Desktop or portable units must only be operated and
controlled in enclosed housings.

252 Danger of unintended starting up of machines

e Install automation devices and related operating elements in a way that
they are well protected against unintentional operation.

e Emergency stop devices complying with IEC/EN 60204-1 must be
effective in all operating modes of the automation devices. Unlatching
the emergency-stop devices must not cause restart.

e You must take safety precautions (emergency switching off) in the
external circuitry of the gateway and any power modules type EU5C-
SWD-PF1-1 or EU5C-SWDPF2-1 that are used. To do so, plan to
switch off the power supply to the contactor coils AUX.

o Measures should be taken to ensure the proper restart of programs
interrupted after a voltage dip or failure. This should not cause
dangerous operating states even for a short time. If necessary,
emergency stop devices should be implemented.

o Wherever faults in the automation system may cause damage to
persons or property, external measures must be implemented to ensure
a safe operating state in the event of a fault or malfunction (for example,
by means of separate limit switches, mechanical interlocks etc.).

SmartWire-DT Gateway | EU5C-SWD-POWERLINK © Hilscher 2013 — 2015
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2.6 Safety instructions to avoid property damage

To avoid damage to your gateway or your communication system, you
must read, understand and follow the following safety instructions and all
safety instructions and warnings in this manual concerning property
damage, before you install and operate the gateway.

2.6.1 General safety instructions concerning supply voltage

In safety-relevant applications the power supply providing power to the
SmartWire-DT system must feature a PELV power feed module
(protective extra low voltage).

Switch off the power supply if you are reconnecting slaves in the
SmartWire-DT system or reconnecting the ribbon cable connection.
Otherwise the SmartWire-DT slaves can be destroyed!

The gateway has protection against polarity reversal for the 24-V-DC-
POW supply. However, if the gateway is connected via the serial
interface to an earthed device (for example to a PC), the gateway can
be destroyed, if the polarity of the power supply is reversed!

The functional earth (FE) must be connected to the protective earth
(PE) or to the potential equalization. The system installer is responsible
for implementing this connection.

Connecting cables and signal lines should be installed so that inductive
or capacitive interference does not impair the automation functions.

Suitable safety hardware and software measures should be
implemented for the 1/0O interface so that a line or wire breakage on the
signal side does not result in undefined states in the automation
devices.

2.6.2 Device destruction by exceeding allowed supply voltage

The gateway must only be operated with the specified supply voltage.

Make sure that the limits of the allowed range for the supply voltage are
not exceeded. A supply voltage above the upper limit can cause severe
damage of the gateway!

A supply voltage below the lower limit can cause malfunction of the
gateway!

Ensure a reliable electrical isolation of the low voltage for the 24 volt
supply. Only use power supply units complying with IEC 60364-4-41
(VDE 0100 Part 410) or HD 384.4.41 S2.

The allowed range for the supply voltage is indicated in section Technical
data EU5C-SWD-POWERLINK gateway [ page 75].
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2.6.3 Electrostatic sensitive device

The gateway is sensitive to electrostatic discharge, which can cause
internal damage and affect its normal operation. Therefore adhere to the
necessary safety precautions for components that are vulnerable to
electrostatic discharge when you install or remove the gateway. Follow the
guidelines listed hereafter when you handle the gateway:

e Touch a grounded obiject to discharge potential static before you handle
the gateway.

e Wear an approved grounding wrist strap.
e If possible, use a static-safe workstation.
e When not in use, store the device in appropriate static-safe packaging.
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2.7 Labeling of safety messages

In this document the safety instructions and property damage messages
are designed according both to the internationally used safety conventions
as well as to the ANSI 2535 standard.

The Section Safety Messages at the beginning of a chapter are
pinpointed particularly and highlighted by a signal word according to the
degree of endangerment. The kind of danger is specified exactly by the
safety message text and optionally by a specific safety sign.

The Integrated Safety Messages embedded in operating instructions
are highlighted by a signal word according to the degree of
endangerment. In the safety message, the nature of the hazard is
indicated.

Signal words and safety signs in safety messages on personal injury

Signal word

Meaning

A DANGER

Indicates a direct hazard with high risk, which will have as consequence
death or grievous bodily harm if it is not avoided.

Indicates a possible hazard with medium risk, which will have as
consequence death or (grievous) bodily harm if it is not avoided.

A\ CAUTION

Indicates a minor hazard with medium risk, which could have as
consequence personal injury if it is not avoided.

Table 7: Signal words in safety messages on personal injury

Safety sign

Sort of warning or principle

A\

Warning of lethal electrical shock

-
[O]-D-

Principle: Disconnect the power plug

Table 8: Safety

Signal word
damage

signs in messages on personal injury

s and safety signs in safety messages on property

Signal word

Meaning

Indicates a property damage message

Table 9: Signal

words in safety messages on property damage

Safety sign | Sort of warning or principle
A Warning of property damage by electrostatic discharge
AL

Table 10: Safety signs in safety messages on property damage
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3 Device description EUSC-SWD-POWERLINK gateway

3.1  Function

The EU5C-SWD-POWERLINK Gateway integrates a SmartWire-DT
network into an Ethernet POWERLINK network. The Gateway creates a
data connection between the participants (the slave devices) of the
subordinate SmartWire-DT network and the Managing Node (the master
device or PLC) of the super ordinate POWERLINK network.

The gateway acts as master in the SmartWire-DT network on the one hand,
and on the other hand as modular Controlled Node (slave device) in the
POWERLINK network. It thereby presents each connected SmartWire-DT
participant as individual module to the POWERLINK Managing Node.

The cyclic process data is exchanged transparently between both
networks. 1000 Bytes of process input/output data can in sum be
exchanged with up to 99 SmartWire-DT participants (slaves).

ontrolled|  (Controlled
Node Node
POWERLINK ﬂ r[

POWERLINK
SPS
(Managing
Node)

Ethernet (="t lled ™\

Interface Node

——

EUSC-SWD-POWERLINK
Gateway

Slave1 Slave2 3|989VO

SmartWire SWD

\_ | Interface = Master / @D

SmartWire-DT

Slave 1 Slave 2 Slave 99
(XX

Figure 1: Data flow EU5C-SWD-POWERLINK gateway
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3.2 Configuration

There are three types of configurations that are relevant for commissioning
and operating the EU5C-SWD-POWERLINK gateway.

The actual configuration is the current actual constellation of the devices
at the SmartWire-DT bus connected to the SmartWire-DT interface of the
gateway. It is always scanned after each restart of the gateway. This
procedure cannot be influenced.

In case the actual configuration complies with the configuration envisaged
for operation, the actual configuration can be captured as target
configuration and stored zero-voltage safe in the device. This capturing
and storing of the actual configuration as target configuration can be
achieved either by pressing the configuration button located at the front
panel of the gateway or by using the SWD-Assist software (for the position
of the configuration button, see section Device picture [ page 27]).

This target configuration is then available within the gateway even after
power-off or restart of the device. If a target configuration has been stored,
the gateway checks on each restart whether the actual configuration
complies with the target configuration. In case the gateway detects
inadmissible deviations, it will not go into operation. If the actual
configuration deviates from the target configuration because of a device
failure or removal on the SWD bus, the SWD LED on the gateway starts to
blink red (for the position of the SWD LED, see section Positions of the
LEDs [ page 28]).

If no errors are detected, the gateway is in principle ready for operation, but
remains in waiting until the so-called planned configuration is downloaded
to the gateway via the SWD-Assist software.

Without a target configuration, the gateway will not go into operation. The
target configuration therefore has to be generated

¢ when you commission the gateway for the first time,
e after replacing a SmartWire-DT slave or

e after deliberately changing the setup of the SmartWire-DT network in
any other way.

The third configuration is the planned configuration (in this document also
called project configuration). It is created by using the SWD-Assist
software and contains the desired configuration and the parameters of the
SmartWire-DT network. It can be manually created in SWD-Assist by
adding the individual device symbols in the “workbench” window, or it can
be automatically created by taking over (i. e. reading-in) the target
configuration from the gateway. The latter method is less prone to errors
and therefore recommended.

The project configuration has to be complemented in SWD-Assist with the
device-specific parameters of the SWD slaves and the POWERLINK-
specific parameters (i. e. the node ID of the gateway). It then has to be
downloaded from the configuration PC to the gateway via USB, where it is
stored (like the target configuration) zero voltage-safe in the flash memory
of the device.

SmartWire-DT Gateway | EU5C-SWD-POWERLINK © Hilscher 2013 — 2015
DOC130802UMO4EN | Revision 4 | English | 2015-06 | Released | Public



Device description EUSC-SWD-POWERLINK gateway 23/81

The gateway checks the project configuration against the target
configuration after each restart. SWD-Assist lets you define individual SWD
slaves in the project configuration as being “non-mandatory” (which means
that these slaves are allowed to be missing in the target configuration).
Thus project configuration and target configuration must not necessarily
comply with each other, but must be compatible. The result of this checking
is indicated by the Config LEDon the gateway (for the position of the
Config LED, see section Descriptions of the LEDs [ page 29]).

In order to acquaint the gateway with the POWERLINK Managing Node
within its POWERLINK configuration, you have to generate an XDD device
description file out of the project configuration in SWD-Assist, and then and
export it. This file contains the projected/planned configuration of the
gateway in a standardized description format, which complies with general
POWERLINK specifications. The XDD file then has to be imported into your
POWERLINK engineering tool (e. g. Automation Studio by B & R).
Afterwards, you can add the gateway in the engineering tool to an already
existing POWERLINK project as Controlled Node and perform a data
mapping for the contained I/O modules (i. e. the SmartWire-DT slaves).
Finally, you can load the project onto your POWERLINK Managing Node.

3.3 Interfaces

The gateway features a SmartWire-DT interface (plug, 8-pole), a 2-port
switch Ethernet interface (RJ45) for connecting POWERLINK, and a Mini-
USB interface. Via the Mini-USB interface, the gateway can be accessed,
configured and diagnosed with the SWD-Assist software.

3.4 Diagnosis

The gateway can be diagnosed by connecting the SWD-Assist software to
the Mini-USB interface. For further information, please refer to the SWD-
Assist online help.

The POWERLINK protocol also provides diagnostic functions. For further
information, see section Diagnose/Status Response.
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3.5 Firmware and device description file

The EU5C-SWD-POWERLINK Gateway is shipped with its most recent
firmware already loaded. Which firmware version is loaded in the gateway
at the time of delivery can be inferred from the device type label (see
section Device type label [ page 32]).

You can update the firmware from your configuration PC by using an
ordinary web browser.

A web server embedded in the gateway provides a special web page for
updating the firmware. This web server can be accessed via the Ethernet
interface of the Gateway. For more details on this, please refer to the
chapter Updating firmware [' page 65].

In case of a missing or defective firmware, a firmware “recovery” process is
possible via HTTP. Please refer to the chapter Firmware recovery via HTTP
[ page 70].

A device description file in XDD format can be generated by the SWD-
Assist software. It can then be imported into a POWERLINK engineering
tool (like e. g. Automation Studio by B & R).
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4 Requirements for operation

The following prerequisites must be fulfilled to operate the gateway:

4.1 Network systems

o SmartWire-DT network with maximum number of up to 99 participants/
stations/slaves and maximum extension of up to 600 meters.

o Ethernet POWERLINK network with POWERLINK PLC (Managing
Node). Maximum cable length for one segment (i. e. cable between two
devices or hubs) is 100 meters.

4.2 Power supply
ADWARNING

Danger of unsafe operation of the system

In safety-relevant applications the power supply providing power for the
SmartWire-DT system must feature a PELV power feed module (protective
extra low voltage).

Danger of unsafe operation of the system

You must take safety precautions (emergency switching off) in the external
circuitry of the gateway and any power modules type EU5C-SWD-PF1-1 or
EU5C-SWDPF2-1 that are used. To do so, plan to switch off the power
supply to the contactor coils AUX.

Device destruction

Ensure a reliable electrical isolation of the low voltage for the 24 volt
supply. Only use power supply units complying with IEC 60364-4-41 (VDE
0100 Part 410) or HD 384.4.41 S2.

0 Important:

Please take into consideration the total power consumption of your
SmartWire-DT network and, if necessary, plan for an additional
feeder module EU5C-SWD-PF2.

You can find information on the power consumption in the operating
manuals of the SmartWire-DT devices.
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4.2.1 POW power connection

A Power supply of 24 V DC for the coupling unit and for the Smart-Wire-DT
slave electronics is needed at the connection POW.

On the SmartWire-DT gateway, connect the POW and AUX supply
voltages via separate miniature circuit-breakers or fuses:

Miniature circuit-breaker 24 V DC for POW

e (Cable protection in accordance with DIN VDE 0641 Part 11, IEC/EN
60898:
Miniature circuit-breaker 24 V DC rated operational current 3 A; trip
types C or Fuse 3 A, utilization class gL/gG

e Cable protection for cable AWG 24 in accordance with UL 508 und
CSA-22.2 No. 14:
Miniature circuit-breaker 24 V DC rated operational current 3 A; Tripping
characteristics C or Fuse 3 A

4.2.2 AUX power connection

If any switching devices are also to be connected, for example via the DIL-
SWD-32-001/002 SmartWire-DT slaves, a 24 V DC supply will also be
required at the AUX power connection. This provides the supply for
activating the contactor coils. This supply must be protected by an
automatic circuit-breaker (3A gG/gl or 3 A miniature circuit-breaker with a Z
characteristic).

If switching devices with an activation power greater than 3 A are
connected, an additional feeder module EU5C-SWD-PF1 or EU5C-SWD-
PF2 must be used.

On the SmartWire-DT gateway, connect the POW and AUX supply
voltages via separate miniature circuit-breakers or fuses:

Miniature circuit-breaker 24 V DC for AUX

e (Cable protection in accordance with DIN VDE 0641 Part 11, IEC/EN
60898:
Miniature circuit-breaker 24 V DC rated operational current 3 A; trip type
Z or Fuse 3 A, utilization class gL/gG

e Cable protection for cable AWG 24 in accordance with UL 508 und
CSA-22.2 No. 14:
Miniature circuit-breaker 24 V DC rated operational current 2 A; Tripping
characteristics Z or Fuse 2 A
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5 Device picture, connectors and LEDs

5.1 Device picture

\ (1) 24V power supply POW

(2) Ethernet POWERLINK interface (RJ45)

T’ (3) LEDs communication status POWERLINK (see
@ subsequent section for details)
\
@\ o000
i e c (4) Mini-USB interface
@_.! = (5) Configuration button

(6) LEDs gateway functions (see subsequent section
for details)

(7) 24V power supply AUX

(8) SmartWire-DT connection (plug, 8-pole)

Table 11: Front view EU5C-SWD-POWERLINK gateway
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5.2 Positions and meaning of the LEDs

521 Positions of the LEDs

Q ®\ @ @ (1)  POW: System status

AUX

(2)  APL: Application status

APL Conflg (3)  Config.: Configuration status

@ cConfig. (4)  SWD: SmartWire-DT status

\\' / (5) BS: POWERLINK bus status

BS@ @'BE (6)  BE: POWERLINK bus error

CF{5/DIAG

(7)  LIA: LINK/Activity for channel 0

(8)  Receive/Transmit (RX/TX) for channel 0

9) L/A: LINK/Activity for channel 1

EU5C-SWD-POWERLINK

(10) Receive/Transmit (RX/TX) for channel 1
24V

Table 12: LEDs EU5C-SWD-POWERLINK gateway
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5.2.2

Descriptions of the LEDs

LED Color | State | Meaning
POW Duo LED yellow/green
System status yellow On Firmware and operating system are running.

Number in — - - - -
picture: 302 Flashing green/ | Second Stage Bootloader is not able to load firmware. The device
yellow needs to be sent-in for servicing.

(1) (green/ I ds to be sent-in f ici

yellow)

o (green) On Backup firmware is active. The gateway needs a firmware recovery as
described in chapter Firmware recovery via HTTP [ page 70]
'::is(green) Flashing green | ROM loader is not able to find bootable image. The device needs to be
sent-in for servicing.
) (off) Off Power supply for device is missing or hardware defect.
APL Duo LED red/green
Application ® green) |On The communication on POWERLINK and SmartWire-DT is in cyclic
status data exchange and the gateway function is executed.
Number in '::is(green) Flashing Gateway is initialized, but the communication on POWERLINK or
picture: (2) 1s off, SmartWire-DT is not in cyclic data exchange.
1son
'::::E(red) Flashing Gateway is initialized, but the SmartWire-DT configuration is missing
1 s off, or in error.
1son
o (red) On Gateway has detected an error during the initialization: Missing
configuration, error in configuration or internal error.
Config. Duo LED red/green
Configuration "o (green) | ON The project configuration complies with the target configuration. Data
status exchange between gateway and PLC via POWERLINK is possible.
Number in '::is(green) Flashing The project configuration does not comply with the target
picture: (3) configuration, but is compatible with it. Data exchange between
gateway and PLC via POWERLINK is possible.
o (red) On The project configuration and the target configuration are not
compatible. Data exchange between gateway and PLC via
POWERLINK is not possible.
) (off) Off No communication with the POWERLINK PLC, or the gateway does
not have a project configuration.
Table 13: Descriptions of the LEDs
LED Color | State | Meaning
SWD Duo LED red/green/orange(orange = red/green at the same time)
Status . ; ; : . ;

i o On The actual configuration complies with the target configuration.
SmartWire-DT (green) Data exchange between gateway and SmartWire-DT slaves takes
Number in place.
picture: (4) '::éi:'(red) Flashing The gateway misses its target configuration or a necessary

SmartWire-DT slave is missing or the target configuration does not
comply with the actual configuration.
No data exchange between gateway and SmartWire-DT slaves.

'::éis(green) Flashing Slave addressing is active (after power-on or download of a project
configuration containing empty modules).

No data exchange between gateway and SmartWire-DT slaves.

() (red) On Short-circuit on the 15 V power supply or no SmartWire-DT slave is
connected. No data exchange between gateway and SmartWire-DT
slaves.

Flashing After having pressed the configuration button: The gateway reads the
(orange) > ’ : ) .
actual configuration and stores it as target configuration.
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LED Color | State | Meaning

BS Duo LED red/green

POWERLINK Off Controlled Node (gateway) is initialized

Bus Status ® (off) (9 y)

Number in '::éis(green) Flickering Controlled Node (gateway) is in basic Ethernet state

picture: (5) Single Flash | Controlled Node (gateway) is in state “Pre-Operational 1”
Double Flash |Controlled Node (gateway) is in state “Pre-Operational 2”
Triple Flash Controlled Node (gateway) is in state “ReadyToOperate”
On Controlled Node (gateway) is in state “Operational”
Blinking Controlled Node (gateway) is in state “Stopped”

BE Duo LED red/green

POWERLINK
Off N

Bus Error ® (off) o error

Number in ® ) On Controlled Node (gateway) has detected an error

picture: (6)

L/A (RJ45) LED green

Cho & Cht o (green) On Link: Gateway has connection to Ethernet

Numbers in — - — -

picture: *%¥(green) Flashing Activity: Gateway sends/receives Ethernet frames

(7)&(9) ) (off) Off Gateway has no connection to Ethernet

(RJ45) LED yellow

Cho & Cht (yellow) This LED is not used

Numbers in

picture:

(8) & (10)

Table 14: Description of the LEDs (2)
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5.3 Pinning of the Real-Time Ethernet interface

The following picture shows the pinning of the POWERLINK interface of the

gateway.

Ethernet

Channel 0

Ethemet
Channel 1

Figure 2: Pinning of the Ethernet interface (RJ45)

PIN 1. TX
_/_pm Z TX-
— P

—————FIN & RX-

PIN 1. TX+
— —PINZTX-
=—__PIN 3 RXs

= PIN & RX

IN 3. RX
=" PIN 4 TERM
PIN 5 TERM

—~——PIN 7: TERM
xpm 8 TERM

PIN 4 TERM
——PIN & TERM

\x_rﬁm 7 TERM

PIN 8 TERM

Pin (Signal

Description

TX +

Transmit Data +

X -

Transmit Data —

RX +

Receive Data +

TERM

TERM

Bob Smith Termination

RX -

Receive Data —

TERM

O|IN|O|O|BR|W[IN|=

TERM

Bob Smith Termination

Table 15: Ethernet interface channel 0 and channel 1 pin assignment (RJ45)

) Note:
. The Ethernet interface supports auto crossover.

SmartWire-DT Gateway | EU5C-SWD-POWERLINK

DOC130802UMO4EN | Revision 4 | English | 2015-06 | Released | Public

© Hilscher 2013 — 2015



Device picture, connectors and LEDs

32/81

5.4 Device type label

Each EU5C-SWD-POWERLINK gateway carries a device type label, which
provides the following information:

®\' Version X.X.X.X

@\DC 24V(AUX), max. 3A
DC 24V(POW), max. 0.6A
‘ AWG 2416
| Operating amb. temp. -25...+55°C &m‘ Q
838 ). 00) 8
EU5C-SWD-POWERLINK K= &

€.

N

—
—_— — ~— — — ~—

-®

www_ hilscher.com % 8233921 3.

—~
a

—_ =
D

©

Version of firmware (at time of delivery)

Information on power supply for switching devices
(AUX)

Information on power supply for Gateway and
Smart-Wire-DT slaves (POW)

Information on wire gauge of power supplies
Operating ambient temperature

Device type name

Part number

Hardware revision number

Serial number

Table 16: Device type label EU5C-SWD-POWERLINK
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6 Getting started

The following table provides an overview of the steps necessary for
installing and commissioning the EU5C-SWD-POWERLINK Gateway.

# Step For details see

1 Install gateway Chapter Installing gateway [ page 34]

1.1 Take safety precautions Section Safety messages [ page 34]

1.2 Mount gateway onto top hat rail Section Mounting gateway onto top hat rail [ page 35]

1.3 Connect gateway to power supply Section Connecting gateway to power supply [ page 38]

14 Connect gateway to SmartWire-DT network |Section Connecting SmartWire-DT [ page 40]

2 Configure gateway Chapter Configuring gateway [ page 42]

2.1 Configure SmartWire-DT network in gateway | Section Configuring SmartWire-DT network in gateway

(creating target configuration) [ page 42]

2.2 Install SWD-Assist and USB driver on Section Installing SWD-Assist and USB driver on configuration
configuration PC PC [ page 44]

2.3 Connect configuration PC to gateway via Section Connecting gateway to configuration PC via USB [
USB page 46]

24 Configure gateway project in SWD-Assist Section Configuring gateway in SWD-Assist (creating project

25 Download project configuration to gateway | configuration) [ page 47]

3 Configure gateway in POWERLINK Chapter Configuring gateway in POWERLINK [ page 52]

3.1 Create XDD device description file for Chapter Configuring gateway in POWERLINK [ page 52]
gateway in SWD-Assist

3.2 Import XDD device description file in
POWERLINK engineering tool

3.3 Configure gateway in POWERLINK
engineering tool

3.4 Download POWERLINK configuration to PLC

3.5 Connect gateway to POWERLINK network | Section Connecting POWERLINK [+ page 41]

Table 17: Getting started
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7/ Installing gateway

7.1 Safety messages

Electrical shock

A Please observe the following safety messages when you install and handle
O3S the gateway:

» First disconnect the power plug of the device.
» Make sure that the power supply is off at the device.
» Cover or enclose neighboring units that are live.

A
Ol NOTICE

Electrostatic Sensitive Device

The gateway is sensitive to electrostatic discharge, which can cause
internal damage and affect its normal operation. Therefore adhere to the
necessary safety precautions for components that are vulnerable to
electrostatic discharge, when you install or handle the gateway:

» Do not touch the metal pins of the connectors of the gateway.
» Touch a grounded object to discharge potential static.
» Wear an approved grounding wrist strap.
» If available, use a static-safe workstation.
» When not in use, store the device in an appropriate static-safe
packaging.
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7.2 Mounting gateway

No tools are required for mounting the EU5C-SWD-ETHERCAT Gateway
onto a top hat rail. The back of the gateway (1) carries a spring-fitted bolt
(2) by which the gateway can be clamped to the rail (3).

Figure 3: Mounting principle of the gateway

7.2.1 Mounting gateway onto top hat rail

To mount the gateway onto the top hat rail, proceed as follows:

_ Electrical shock: Make sure that the gateway is disconnected
from any power supply! Cover or enclose neighboring units that are live!

» Tilt the gateway slightly and hook it into the upper
railing from above, thereby pushing down the
gateway with slight force, in order to overcome the
resistance of the spring in the bolt.

Hook gateway to upper railing
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» Keep on pushing the gateway downwards and filt it
back into vertical position, thereby hooking the
gateway into the lower railing.

Hook gateway to lower railing

» Let go of the gateway. The spring inside the bolt
automatically pushes the gateway upwards into
the railings, thereby fixing the gateway to the top 3.
hat rail.

Gateway is clamped to top hat rail
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7.2.2 Removing gateway from top hat rail

To remove the gateway from the top hat rail, proceed as follows:

_ Electrical shock: Make sure that the gateway is disconnected
from any power supply! Cover or enclose neighboring units that are live!

» Push down the gateway with slight force (to
overcome the resistance of the spring in the bolt),
then unhook the gateway first from the lower railing
and then from the upper railing.

Unhook gateway
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7.3 Connecting gateway to power supply

Danger of lethal injuries by unexpected starting up of motors or
machinery!

If you have already integrated devices into a system, secure the operating
range of any connected parts of the system against access, so that nobody
is endangered by motors or machinery starting up unexpectedly.

Danger of unsafe operation of the system

In safety-relevant applications the power supply providing power for the
SmartWire-DT system must feature a PELV power feed module (protective
extra low voltage).

Danger of unsafe operation of the system

You must take safety precautions (emergency switching off) in the external
circuitry of the gateway and any power modules type EU5C-SWD-PF1-1 or
EU5C-SWDPF2-1 that are used. To do so, plan to switch off the power
supply to the contactor coils AUX.

0 Important:

Please take into consideration the total power consumption of your
SmartWire-DT network and, if necessary, plan for an additional
feeder module EU5C-SWD-PF2. You can find information on the
power consumption in the operating manuals of the SmartWire-DT
devices.

» Connect the 24 V DC voltage to the POW terminals on the front side of
the gateway. The POW connection provides the voltage for the gateway
itself and for the SmartWire-DT slave electronics.

) Note:

. For the 15 V supply of the SmartWire-DT slaves, the gateway
contains an additional power feed module with an amperage of
0.7 A.
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» If necessary, connect the 24 V DC voltage for the contactor coils to the
AUX terminals on the front side of the gateway.

24V DC
ov

AR

£1]) 24V
Ojov

AUX
0000

O

i

4
4

a0 24V
gm oV

Figure 4: Gateway power supply

POW!

) Note:

. The AUX supply is required if any switching devices are also to be
connected, for example, via the DIL-SWD-32-001/002 SmartWire-
DT slaves. The AUX connection provides the supply for activating
the contactor coils.
This supply must be protected by an automatic circuit-breaker (3A
gG/gl or 3 A miniature circuit-breaker with a Z characteristic).
If switching devices with an activation power greater than 3 A are
connected, an additional feeder module EU5C-SWD-PF1 or EU5C-
SWD-PF2 must be used.

Potential conditions between the components

The entire SmartWire-DT system operates on a common supply voltage.
Provide a common star point for the earth wiring. In this way, the various
slaves in the SmartWire-DT system will not be electrically isolated from one
another.

The POWERLINK network and the SmartWire-DT system are electrically
isolated from one another.
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7.4 Connecting SmartWire-DT

» Connect the SmartWire-DT network to the gateway. To do so, use the
SmartWire-DT cable SWD4-100LF8-24 and the SWD4-8MF2 relevant
blade terminal or prefabricated cables of type SWD4-(3/5/10)F8-24-2S.

Figure 5: Connecting SmartWire-DT to gateway

Device destruction

Switch off the power supply before you are reconnecting slaves in the
SmartWire-DT system or reconnecting the ribbon cable connection.
Otherwise the SmartWire-DT slaves can be destroyed!

plug (SWD4-8SF2-5) to the 8 pole Smart-Wire-DT cable are
provided in chapter Fitting external device plugs SWD4-8SF2-5 of
the manual SmartWire-DT — The System, MN05006002Z-EN
(previously AWB2723-1617en).

Detailed instructions on adapting the SmartWire-DT external device
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7.5 Connecting POWERLINK

» Connect the RJ45 plug of the POWERLINK cable to one of the Ethernet
connectors on the gateway.

Figure 6: Connecting POWERLINK to gateway

0 Important:
Please observe the following notes on POWERLINK cabling:
» Use only hubs, no switches.
» Maximum cable length in a segment (allowed space between
individual devices/hub) is 100 meters.

7.6 EMC-conformant wiring of the network

Undesired faults can occur on the bus due to electromagnetic interference.
This can be minimized beforehand by the implementation of suitable EMC
measures. These include:

¢ EMC-conformant system configuration,
e EMC compliant cable routing,

o Measures that do not allow the occurrence of large differences in
potential and

e correct installation of the POWERLINK system (cables, connection of
the bus connectors, etc.)

The effects of electromagnetic interference can be significantly reduced by
fitting a shield.

Industrial Ethernet -Planning and Installation Guide by IAONA e.V.

For more detailed information on this, please refer to the JAONA
Magdeburg, Germany.
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8 Configuring gateway

For data exchange between the gateway and the POWERLINK Managing
Node, the gateway needs valid target and project configurations of the
SmartWire-DT network. This chapter describes how to create and store
these configurations in the gateway.

8.1 Configuring SmartWire-DT network in gateway (creating
target configuration)

When you commission the gateway, you have to read-in the actual
configuration of the SmartWire-DT network (i. e. the line-up of the
participants/devices connected to the SWD bus) and store it as target
configuration.

Reading and storing the SmartWire-DT network configuration takes place
by pressing the configuration button on the gateway (for the position of the
configuration button, see section Device picture [ page 27]). All
SmartWire-DT slaves are re-addressed in ascending order by this process.
As an alternative, you can generate and store the target configuration by
using the SWD-Assist software (the gateway must be connected to SWD-
Assist via USB).

This process should only take place in the case of:
¢ initial commissioning,

e replacement of a defective slave or

¢ deliberate change to the configuration.

Hazard of device damage by disruption of voltage supply while
creating target configuration!

Do not interrupt the voltage supply while creating the target configuration of
the gateway. Power failure during a writing process in the file system can
cause severe malfunctioning of the device.

o Important:

If there is a faulty configuration and the configuration button is
pressed, only the slaves up to the failed device are addressed and
stored. Use of the remaining slaves is not possible until the
defective slave has been replaced and the configuration has been
read-in again by pressing the configuration button.

The remanently stored target configuration is compared with the current
configuration (actual configuration) each time the gateway is restarted and
during bus operation. If the gateway recognizes that a required SmartWire-
DT slave cannot be reached or a wrong slave type is determined, the
gateway will not go into operation or stops operating. This depends in each
case on the setup of the network which has been defined in the planned/
project configuration. In case of error, the SmartWire-DT status LED (SWD
LED) starts to blink in red (for the position of the SWD LED, see Positions
of the LEDs [ page 28])).
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If a SmartWire-DT slave has failed, the SmartWire-DT network can still be
operated with the remaining slaves, depending on the settings in the
planned/project configuration (even after a repeated power up of the
gateway). The failure is reported to the application.

Prerequisites for reading-in the SmartWire-DT configuration are:
e All SmartWire-DT slaves are connected to the SmartWire-DT line.

The SmartWire-DT network is connected to the gateway.

The voltage POW is applied to the gateway and the power LED POW is
on.

The voltage AUX is applied (if necessary).

The SmartWire-DT status LEDs of the individual SmartWire-DT slaves
are on or are flashing.

The POWERLINK network is disconnected from the gateway by
removing the RJ45 plug from the Ethernet interface of the gateway.

To read-in the SmartWire-DT configuration proceed as follows:

» Make sure that POWERLINK is disconnected from the gateway.

» Press the configuration button on the gateway for at least two seconds
(for the position of the configuration button, see section Device picture |
page 27]).

) Note:

. Take care to push-in the button properly. You have to feel and
overcome a slight resistance at the end when pushing the button
into the gateway, otherwise the button won'’t trigger.

2 The SmartWire-DT status LED (SWD LED) on the gateway begins to
flash orange. The SmartWire-DT status LEDs on the SmartWire-DT
slaves also flash. All slaves are addressed in sequence, the complete
configuration is stored retentively as gateway target configuration.

Hazard of device damage by disruption of voltage supply while
creating target configuration!

Do not interrupt the voltage supply while creating the target configuration of
the gateway. Power failure during a writing process in the file system can
cause severe malfunctioning of the device.

= The SmartWire-DT status LED (SWD LED) on the gateway shows
steady green.
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8.2 Installing SWD-Assist and USB driver on configuration PC

You need the SWD-Assist software on your configuration PC in order to
create, parameterize and download a project configuration to the gateway.
With SWD-Assist, you can also perform a diagnosis of the SmartWire-DT
network and create an XDD device description file, which can imported into
your POWERLINK engineering tool for the purpose of configuring the
POWERLINK Managing Node.

In the installation wizard of the SmartWire-DT Gateway Solutions DVD, you
can install the version of the SWD-Assist software delivered on the DVD, or
you can choose to be directed to an internet website from which you can
download the latest version of SWD-Assist (if available).

In order to establish an USB connection between SWD-Assist and the
gateway, you also need to install the USB driver on your configuration PC.
An installation program for the USB driver is delivered on the SmartWire-
DT Gateway Solutions DVD. It contains all components needed for the
installation of the driver under Windows XP, Windows Vista, Windows 7
and Windows 8. It detects whether the 32 bit or the 64 bit version of the
driver needs to be installed.

It is recommended to use the installation program to install the USB driver.
It is also recommended to install the USB driver before you connect the
gateway to your configuration PC via USB for the first time (“software first”
principle).

Step-by-step Instructions

To install the software on your configuration PC, proceed as follows:

» Insert the SmartWire-DT Gateway Solutions DVD into your local DVD-
ROM drive.

2 If the “Auto Play” function of your Windows PC is enabled, the start
screen of the DVD is displayed.

9 Note:

. As an alternative, you can also open the start screen of the DVD by
double-clicking the SmartWire.exe file in the root directory of the
DVD.

» In the menu of the start screen, click Install Planning and
Configuration Tools.
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2> The SmartWire-DT Installation Wizard opens:

% SmartWire-DT

- Choose of Following install options:
-

a USE driver
== "] Download Center SWD-Assist, manual update check
1 SWD Planning Software SWD-Assist V1,90
= "] Ethernet Device Scanner/Configuration Tool
H ] PROFINET GSDML file
8

< |

3 L www.hilscher.com
h |v License agreement (click here) read and accepted

wWindows XP S5p3 (x86) Execute

Figure 7: SmartWire-DT Installation Wizard

9 Note:

. The wizard automatically checks for already installed software
components (which e. g. might have been installed for an earlier
project), and lists the missing components accordingly.

A\

Select the appropriate installation options.

» Read the license agreement, then select License agreement read and

accepted.

» Click Execute, then follow the instructions of the installation program.

9 Note:

. Under Windows XP, the installation process of the USB driver is not
yet finished after having executed the driver setup.
The installation process has to be completed in the Found New
Hardware Wizard, which automatically opens when you connect
the gateway to your configuration PC via USB cable for the first time

(see following section).
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8.3 Connecting gateway to configuration PC via USB

» Make sure that the gateway is connected to a voltage supply.

» Connect the Mini USB interface of the gateway with a USB interface of
your configuration PC (for the position of the USB interface on the
gateway, see section Device picture [ page 27]).

Windows XP:

When you connect the gateway via USB for the first time to a PC running
under Windows XP, the Found New Hardware Wizard opens:

» Answer the question Can Windows connect to Windows Update...?,
with No, not this time. Then click Next button.

» If you have already carried out the setup of the USB driver (as
recommended), you can ignore the wizard’s request to insert a CD or
floppy disk. Answer the What do you want the wizard to do? question
by selecting the Install the software automatically option, then click
Next button.

2 Windows copies the driver files to the Windows directories.
» After the installation is complete, click Finish button.

Windows 7 and 8:

If you have carried out the setup of the USB driver before first connecting
the USB cable (as recommended), the installation will automatically be
finished. Afterwards, the USB connection is instantly operative.

SmartWire-DT Gateway | EU5C-SWD-POWERLINK © Hilscher 2013 — 2015
DOC130802UMO4EN | Revision 4 | English | 2015-06 | Released | Public



Configuring gateway 47/81

8.4 Configuring gateway in SWD-Assist (creating project
configuration)

This section describes how to create and parameterize the project
configuration (also called planned configuration) in SWD-Assist. This
project configuration afterwards has to be downloaded to the gateway, in
order to make it operative.

You can create the project configuration in SWD-Assist by manually adding
the individual SWD participants symbols from the device catalog to the
SWD string in the “workbench” window, or it can be automatically created
by taking over (i. e. reading-in) the target configuration from the gateway
(for a description of how to create the target configuration, see section
SmartWire-DT-Netzwerk in Gateway konfigurieren (Soll-Konfiguration
erzeugen) [ page 42]).

This section describes the easier and faster method of automatically taking
over the target configuration from the gateway.

1. Start SWD-Assist.

» In the Windows Start menu, choose All Programs > Eaton > SWD-
Assist.

R The SWD-Assist software opens.

» If the SWD-Assist catalogue selection dialog window appears,
choose Eaton EMEA option and click OK button.

2 SWD-Assist opens in the Project View:

Untitled1.swd - SWD-Assist 1 EEX

File Edit View Project Communication Options ?

DEESR|aa|Y Qs algpes e &

ERCTctvork infrastructure | P=sremen] EUSC-SWD-DP
& 3 Master modules
- [5] HMI-PLC E T
k3 PLC
=) [8] Network accessories
- [8] Bus termination
- [5] Links
@[S Cables
- [m] Adapter
&3 Power supply units
-3 Inputfoutput modules
=M1 Control circuit devices
= [B M22-5WD Front mount
@ Al 2 positions
[l 3 posttions
- il 2 positions, LED
# HH 3 positions, LED
£l LED elements
= [F3] M22-5WD base fixing
& [F9] M22 surface mounting enclosure

@ [F9 2 positions

@ [F9 3 positions Device i ion | Device SWD

@ [F9 2 positions, LED

& [£1 3 positions, LED EUSC-SWD-DP - (PROFIBUS DP SWD gateway) E:T-N H
@ [F LED elements i S Wikl =

- [F9) FaK foot and palm switch(es) Comment:
= [E3 Interface modules for switchgear
@[] DILMSC 7-38, DILA
@[] DILMSC 7-38 Manual/Auto

Description: Gateway PROFISUS DP / SWD
Power supply unit 15 V: 700 mA Utilization: 0 mA (0%)
AUX power supply unit: 3000 mA Utilization: 0 mA (0%)

&[] PKE 7-32 ManualfAuto

@[5 PKE

- Nzm

- E Soft starters

i[53 CONTACTRON hybrid motor starter
@[] Other elements
@[] Partner device catalogs

Ready 0 module(s) Current consumption since 15V povwer supply unit: OmA ELSC-5WD-DP

Figure 8: Start Window of SWD-Assist

2. Create online connection to gateway.
» To change from the Project View to the Communication View, choose

View > Communication View from the menu bar, or click o button in
the icon bar.
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2> The Communication View opens:
Untitled1.swd - SWD-Assist 1 59((=1E3]
File Edit VYiew Project Communication Options ?
DEH SL|[ 2By QARIQ (S YR58y a2
( Ci ion setup ]
Interface Ethernet Profiles

( Configurations in the device ]

Target configuration
Last saved device scan

Planned configuration
Loaded project

Ready Status display off OFFLINE

Figure 9: Communication View in SWD-Assist

» In the Interface drop-down list below Connection setup, select the
COM port of your configuration PC to which you have connected the
gateway via USB. You can recognize the correct port by the entry next
to the COM port number (Hilscher EU5C-SWD).

> Click Online button.

2 SWD-Assist establishes the online connection and reads-in the target
configuration which had been stored in the gateway. The SWD devices
belonging to the target configuration are depicted as blue symbols
connected to the SWD bus:

Untitled1.swd - SWD-Assist 1 (9[=1E3]
File Edit View Project Communication Options ?
DEHE 9| s A Y| @ % Q| R by 52|y
( Connection setup ) B =557 EUSC-SWD-POWERLINK Display of modules saved in device 2
== @l only in the target configuratior
( Configurations in the device ]
Target configuration
Last saved device scan L
l PC = Device? I l Device => PC I
Planned configuration
Loaded project ¢
12 1 14 1 1
[ PC = Device? l[ Device =3 PC l L - N . - N . . Noesalosersallonern o B e mn| p
Device i i SWD Powerlink Diagnostics | Diagnostics buffer | Hw info
l PC => Device I l Delete I g .
EUSC-SWD-POWERLIHK - ( swp ) hilseher g »
COMPETENCE IN =
COMMUNICATION -’
(Orow @arL @conf @swp)] Description: Gateway Powerlink / SWD
Device:
| Project # Target config. |
SWD stanus:
| Outputs switched off
RUN
Ready Status display off ONLINE
Figure 10: Target Configuration in SWD-Assist
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9 Note:
. If no target configuration has been stored in the gateway yet, you

>

>
>

can create it now by clicking the Renew button in the Target
configuration area in the left window. Thereby, the actual
configuration (i. e. the current line-up of the devices connected to
the SmartWire-DT network) is read-in, stored as target configuration
in the gateway and transferred to SWD-Assist.

. Generate project configuration from target configuration.

In the Target configuration area, click Device => PC button to save
the target configuration from the device in SWD-Assist, in order to adapt
it as project configuration (i. e. planned configuration).

Answer the security question with Yes.
In the Connection setup area, click Offline button.

Edit project configuration.

>

To change from Communication View back to Project View click o2
button or press Ctrl+Alt+1 on your keyboard.

2 In the Project View, the former target configuration is now displayed as

project configuration (i. e. planned configuration):

Untitled1.swd - SWD-Assist 1 EEX
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= [5] Network accessories
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- [5] Links
@[5 Cables
- [5] Adapter
@[3 Power supply units
utjoutput modules
ntrol circuit devices
M22-SWD front mount

LR )
el sa@E s

oEEEE

N
9
2
g
3
E

3 positions

2 positions, LED

3 positions, LED

LED elements.

122-SWD base fixing

M22 surface mounting enclosure
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FaK foot and palm switch(es)

Signal tower

nterface modules For switchgear

DIL/MSC 7-38, DILA

DILJMSC 7-38 ManualjAuto B settings

PKE 7-32 Manualjauto NO1 NC1 NO2 NC2 Required module:
=l

PKE l\_l Can be replaced with universal module: []
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=
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ceE

m
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LEEERE

e}

&

NZM
# [ Drives & Soft starters
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@[] Other elements
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B-8-8

Ready Bus length 4.50m |26 module(s) Current consumption since 15¥ power supply uit: 20mA 2 - M22-5WDK22

Figure 11: Planned Configuration in SWD-Assist: Set Device Parameters

In the Workbench window, select an SWD slave device, then open the
Device Parameters tab in the Properties field window (located below
the Workbench window) and determine whether the device should be a
Required module and whether it Can be replaced with universal
module.
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5. Set POWERLINK parameters in project configuration.
In the Workbench window, select the EU5C-SWD-POWERLINK
gateway.
Untitled1.swd - SWD-Assist 1 (=1t
File Edit “ew Project Communication Options ?
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@[5 DILMSC 7-38 ManualfAuto |
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#- e Nzm
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Figure 12: Planned Configuration in SWD-Assist: Set POWERLINK Parameters of
Gateway

v

» Then open the Powerlink parameters tab in the Properties field

window (located below the Workbench window) and enter the Node-ID
, by which the gateway should be reached in the POWERLINK network.

6. Transfer project configuration to gateway.

» To change from the Project View to the Communication View, choose

View > Communication View from the menu bar, or click OE button in
the icon bar.

2 The Communication View opens.

In the Connection setup area of the Communication View, click Online
button.

2 SWD-Assist re-establishes an online connection, reads-in the target

configuration from the gateway again and displays it in the Workbench
window.

) Note:

. Before downloading the project configuration, you can let SWD-
Assist compare it with the target configuration stored in the gateway
by clicking the PC = Device? button in the Target configuration
area.
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» In the Planned configuration area, click PC => Device button to
transfer the project/planned configuration via USB to the gateway.

9 Note:

. The project configuration is stored in the gateway along with the
target configuration. Any old project configuration file that might
have existed in the gateway up to this point will be overwritten. If an
old project configuration file exists in the gateway, you can let SWD-
Assist compare it with the new project configuration by clicking the
PC = Device? button in the Planned configuration area before
downloading the new one.

= The project configuration is copied to the gateway and stored there non-
volatile. If the project configuration complies with the target
configuration, the Config LED starts to show steady green light after a
few seconds (see also section Positions and meaning of the LEDs |
page 28]).
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9 Configuring gateway in POWERLINK

In order to acquaint the gateway with the POWERLINK Managing Node
within its POWERLINK configuration, you need an XDD device description
file. This file contains the projected/planned configuration of the gateway in
a standardized description format, which complies with general
POWERLINK specifications.

You can generate the XDD file in SWD-Assist from your project
configuration and import it into your POWERLINK engineering tool, e. g.
Automation Studio. There you can add the gateway as Controlled Node to
an already existing POWERLINK project and perform a data mapping for
the projected I/0 modules (i. e. the SmartWire-DT devices). Afterwards you
can load the POWERLINK project onto your POWERLINK Managing
Node.

1. Generate XDD device description file in SWD-Assist.

» Open the project in SWD-Assist. (If you have just recently copied the
project configuration to the gateway — see preceding section — change
from the Communication View back to the Project View.)

2 The Project View shows the project configuration:

Untitled1.swd - SWD-Assist 1 (9((=1E3]
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Figure 13: Planned configuration in SWD-Assist

» In the menu, select Project > Generate XDD file...
2 The Save XDD file dialog window opens.

» Choose the directory where you want to store the XDD file and enter a
file name, then click Save.
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2. Import XDD device description file into Automation Studio.

» Open your POWERLINK project in Automation Studio.

» In the menu of Automation Studio, choose Tools > Import Fieldbus
Device...

2 A file selection dialog window opens.

» Select the XDD device description file, then click Open.
2 The XDD device description file is imported.

. Add gateway to the POWERLINK project.

» In the right window, select the Managing Node of your POWERLINK
project.

e und Ei Admin P\SWD-Gateway\SWD-Gateway.apj/Config1 - Automation Studio V 3.0.81.32 SPO7 # 4:5 479038 |~ [0/
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leq POWERLINK PLCI.CPUSSTIFIST? 1.0
He
g POWERLINK PLCI.CPUSSTIFLSTIT 1.0
leq POWERLINK PLCICPUSSTIFISTR2 10
.3 POWERLINK PLCI.CPUSSTIFISTZE 1.0,
<l >
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File C:\Dokumente und Einstellungen\Administiator\Desktop\S4/D_Gateway.xdd imported successfull. v
Boutput | ™ Debug | EyFind in Files | Ecallstack | 9 Cross Reference | f@Reference List
For Help, press F1 tepip/RT=1000 [DAIP=172,16.3.3 {CKDA=0 JREPO=11159 /ANSL=1 X20CP1485 03.07 RUN

Figure 14: POWERLINK project in Automation Studio

» Open the context menu and choose Insert...
> The Select controller module dialog window opens:

Description [~
Bus Controller POWERLIN
K67 Bus Controller POWEI
K67 Bus Controller POWEI

Select controller module

Model no.

— X67BC8321
— X67BC83211

— X67BC8321.L12

— X67BCE331
'— XE7BC8513.L12

= POWERLINK Devices
— CIFXRE/PLS
EUSE-SWD-PL Unbenannl _}
[~ NxIO 50-RE/PLS
— POWERLINK
— POWERLINKVZICN

= Simulation
SimDevice
= Modbus Devices
L Modbus TCP Slave
Show customized Fz\ Windnms Terminals
(11}
(] products |

@ Insert module

K67 Bus Controller POWEI
K67 Bus Controller POWEI

POWERLINK Devices
Gateway.xdd

Generic POWERLINK Stz
POWERLINK 2 inle[ligen‘ 3
e
Simulation
Simulation Device
Modbus TCP/IP Devices
Generic Modbus Station
Windams Nisnlan Nevices

| [>

[v

[ Nexst > ] [ Cancel ]

Figure 15: Select controller module dialog in Automation Studio

» Make sure that the Insert module option is selected.

» Scroll the list for the Gateway XDD entry and select it. After selecting
the entry, click Next.
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» The Module Parameter dialog window opens:

(Module Parameter \

Module: EUSE-SWD-PL_Unbenannt
System: POWERLINK Devices
Type: POWERLINK controller
Model number: EUSE-SWD-PL_Unbenannt
Module address: hohe
Backplane number:  none
Address: none
Version: 1.0
Enter node number: 10
Must correspond with dial switch setting on the module.
Enter optional hardware
module name:

[ < Back ] I Next > ] [ Cancel ]

Figure 16: Module Parameter dialog in Automation Studio

» In the Enter node number field, enter the Node-ID which you have
assigned to the gateway in the project configuration of SWD-Assist.

> Click Next.

» The Module Parameter dialog window closes and the gateway is
displayed in the POWERLINK project:

% C:\Dok und Einstellungen\A dmini \Desktop\SWD-Gateway\SWD-Gateway. apj/Config1 - A fon Studio V 3.0.81.32 5P07 # 4:5 479038 |~ [0/
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|23 POWERLINK PLCI.CPUSSTIFIST 10, T3 POWERLINK 57239 Generic POWERLINK Station
Fag POWERLINK PLC1.CPU.SS1.IF1.5T5 1.0,
:ﬂ POWERLINK PLCI.CPUSSTIFIST? 10,
|_q EUSESWDPL Ui PLCICPUSSLIFISTIO 10
|23 POWERLINK PLCI.CPUSSTIFISTIT 1.0,
Fag POWERLINK PLC1.CPU.SS1.IF1.5T32 1.0,
LT3 POWERLINK PLCI.CPUSSTIFIST2: 10,
<l i B
™| ogical view | %g Configuration View | & Physical View
Output v ax
Parsing fles for Smart Eit Support . =
Parsing frished
File C:\Dokumente und Einstellungentddministrator\Desktop\SWD_Gateway.xdd imported successfuly. sl
Bloutput | M pebug | GFind in Files | Tl Calistack | % Cross Reference | {8 Reference List
For Help, press F1 tepip/RT=1000 |DAIP=172.16.3.3 JCKDA=0 REPO=11159 {ANSL=1 X20CP1485 03.07 RUN
Figure 17: Gateway in POWERLINK project
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4. Map 1/O data.
» In the left window, select the gateway.

» Open context menu and select Open 1/0 Mapping.
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™8| ogical View | % Configuration view | @dPhysi¢  Go To Master
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For Help, press F1 Properties ... tcpip/RT=1000 [DAIP=172.16.3.3 [CKDA=0 [REPO=11159 JANSL=1 X20CP1485 03.07 RUN

Figure 18: Open I/O mapping

2 In the right window, a list featuring the in- and outputs of the

SmartWire-DT slaves opens:
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Figure 19: I/O Mapping of SWD slaves

» Link the I/0O data to variables.
» Save the project.
5. Load POWERLINK project to PLC via Ethernet.

» In the menu, choose Project > Transfer To Target to compile the

project and load it onto the POWERLINK PLC.
= The project is compiled and loaded to the PLC.
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10 POWERLINK data communication

10.1 Acyclical communication

The POWERLINK Managing Node can exchange acyclic data with
individual SmartWire-DT slaves via the gateway and the Object Index
0x3000. For SDO Write(acyclic output), i. e. for writing data to a SWD
slave (e. g. a read request), the Sub-Index 1is provided. For SDO Read
(acyclic input), i. e. for reading requested data from a SWD slave, the Sub-
Index 2 is provided.

10.1.1  SDO Write (acyclic output)

10.1.1.1 Read request

Elements SDO Write — read request

For writing a read request, use Objectindex 0x3000 together with Sub-
Index 1 and the following elements:

Element Description Data type |[Value range Value Value
example |example in
hex
Slave Address |Address of the SWD slave that you want to  |uint8 1...99 5 0x05
read (i. e. the address defined in the project
configuration)
SWD Index SWD-specific index of the SWD slave. uint8 0...255 127 Ox7F

Determines what kind of data you want to
read, e. g. error counter or firmware version.

Request Type | Type of request: Read or Write Request. uint8 Read 0 0x00
A read request must have the value 0 Request =0
Write
Request =1
Length Maximum length of the expected response |uint8 1...120 120 0x78
(in bytes)

Table 18: Elements read request SDO Write

Example of SDO Write — read request

In case the POWERLINK Managing Node wants to read the error counter
(SWD Index 127) of the 5™ SmartWire-DT slave (slave address 5), and the
expected response should not be longer than 120 Bytes, the SDO Write
sent to the gateway must feature the following values:

Syntax
Object Index Sub-Index Elements
Slave Address SWD Index Request Type Length
0x3000 0x01 0x05 0x7F 0x00 0x78
Table 19: Example read request SDO Write
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10.1.1.2 Write request
Elemente SDO Write — write request
For writing a write request to the SmartWire-DT slave, use Objectindex
0x3000 together with Sub-Index 1 and the following elements:
Element Description Data type |Value range Value Value
example |example in
hex
Slave Address |Address of the SWD slave (i. e. the address |uint8 1...99 5 0x05
defined in the project configuration)
SWD Index SWD-specific index of the SWD slave. uint8 0...255 127 0x7F
Determines where you want write data.
Request Type | Type of request: Read or Write Request. uint8 Read 1 0x01
A write request must have the value 1. Request =0
Write
Request = 1
Length Length of the data to be written (in bytes). uint8 1...120 1 0x01
Data Data to be written. uint8 (-..) 0 0x00
Table 20: Elements write request SDO Write
Example of SDO Write — write request
In case the POWERLINK Managing Node wants to reset the error counter
(SWD Index 127) of the 5™ SmartWire-DT slave (slave address 5), the SDO
Write sent to the gateway must feature the following values:
Syntax
Object Index Sub-Index [Elements
Slave Address |SWD Index Request Type |Length Data
0x3000 0x01 0x05 0x7F 0x01 0x01 0x00

Table 21: Example write request SDO Write
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10.1.2 SDO Read (acyclic input)

Elements SDO Read

The requested data can be read by using Objectindex 0x3000 together
with Sub-Index 2. The response features the following elements:

Element Description Data type |Value range Value Value
example |example in
hex
Slave Address Address of the SWD slave of |uint8 1...99 5 0x05
which data has been read.
SWD Index Address of the SWD slave of |uint8 0...255 127 0x7F
which data has been read.
Request Type Type of request. uint8 Read Request =0 0 0x00
é read request has the value Write Request = 1
Length Length of the received uint8 1...120 120 0x78
response in bytes
Data Actual data which has been uint8 [120] |(...) (...) (...)
read according to SWD Index,
e. g. error counter or firmware
version.
State State of the response. uint8 Idle=0 2 0x02
In Progress = 1
Finished = 2
Error =3
Error Code Error detected by the SWD uint32 No error 0 0x00
master (i. e. by the gateway) = 0x00000000
JOBID_BUFFER_FULL
= 0xCOADO0002
JOB_DENIED
= 0xCOADO0003
NOT_AVAILABLE
= 0xCOADO0004
Table 22: Elements SDO Read
Example SDO Read
In case the response is finished and no error was detected, the SDO Read
(which is sent back by the gateway to the Managing Node in order to
answer the SDO Write) features the following values:
Syntax
Object Index | Sub-Index | Elements
Slave SWD Index Request Type |Length State |Error Code
Address
0x3000 0x02 0x05 0x7F 0x00 0x78 0x02 0x00000000

Table 23: Example SDO Read
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10.2 Error Entry: Error and status messages (diagnosis)

10.2.1  Overview

Errors and status changes of the SmartWire-DT network and errors
occurring in individual SWD slaves are reported by the gateway via Error
Entry object 0x1003.

The quantity of the current diagnoses can be read from the object
0x1003/0. Individual diagnoses are presented in detail from 0x1003/1
onwards.

The gateway stores each error message in its message buffer, from where
it is deleted only after the corresponding error has been resolved (Error
Reset). Resolved errors are also reported by the gateway to the
POWERLINK Managing Node by means of an Error Entry.
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Each Error Entry consists of 20 bytes and has the following structure:

Field

(according to
POWERLINK
specification)

Byte

Function
(according to
gateway
implementation)

Description/range of values

Entry Type

Entry Type

is always 0x70

Entry Type

is always 0x00

Error Code

Message Type

May contain one of the following two values:

0xFF
incoming message about an error of an individual SWD slave or error/status
change of the Gateway/SWD network.

0x00

error of an individual SWD slave has been resolved (Error Reset). Note: this
does not apply to gateway/SWD bus error resets, which are indicated by the
vanishing of the error flags.

Address

Address of the concerned device in the SmartWire-DT network:

0x00
Gateway/SWD master (used for messages about errors/status changes of the
gateway/SWD network).

0x01...0x63
SWD slave 1 to 99 in the SWD network (used for messages concerning
individual SWD slave devices).

Time Stamp

Time Stamp

SoC Nettime from the cycle when the error/event was detected. For details
see POWERLINK specification.

Additional
Information

Diagnosis Code

In case of Address (byte 3) =2 0x01 (error of individual SWD slave), this byte
features a diagnostic code specifying the nature of the error. For details see
section Error messages (diagnosis) of individual SWD slaves [ page 61].

In case of Address (byte 3) = 0x00 (SWD network error/status change
message issued by the gateway), this byte is not used (= 0x00). The nature
of the SWD network error/status message is specified in the Error Flags
(bytes 15 and 16), not in the diagnosis code.

In case of Message Type (byte 2) = 0x00 (resolved error/error reset of
individual SWD slave), this byte specifies the error that has been resolved.

13

14

Not used/reserved

15

16

Error Flags

In case of Address (byte 3) = 0x00 (SWD network error/status change
message issued by the gateway), these bytes feature error flags specifying
the nature of the error/status change. In case of messages about resolved
SWD bus errors, the flag in the corresponding bit disappears. For details see
section SWD bus error and status messages generated by the gateway |
page 63].

In case of Address (byte 3) = 0x01 (error of an individual SWD slave), these
error flags are not used (= 0x00).

17

18

19

Not used/reserved

Table 24: Structure of Error Entry
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10.2.2 Error messages (diagnosis) of individual SWD slaves

New ("incoming") errors are signaled to the POWERLINK Managing Node
by the value 0xFF in the Message Type field (byte 2) of the Error Entry.
The Address of the device reporting the error is provided in the Address
field (byte 3) of the Error Entry: the values 0x01 to 0x63 represent the
consecutively numbered SWD slaves from device 1 to device 99.

The nature of the error is indicated in the Diagnosis Code field (byte 12) of
the Error Entry (the Error Flag fields [bytes 15 and 16] are not used in this
case). The diagnostic codes are defined by the manufacturers of the
individual SWD devices and can thus differ from device to device, you
therefore have to look for the definitions of the codes in the user manual of
the corresponding device (for devices manufactured by Eaton, for example,
this would be the manual SmartWire-DT modules, MN0O5006001Z-EN).

The subsequent table provides some examples of diagnostic codes of
SmartWire-DT slave devices.

Diagnosis Meaning Used by

Code

0x00 No diagnostic message All devices that support the extended
active diagnosis

0x10 Contact in middle position RMQ

0x11 Contact short-circuit RMQ

0x13 Output overload I/O module

Table 25: Examples of diagnostic codes of SWD slaves

In case of a resolved error of an individual SmartWire-DT slave, the
Message Type field (byte 2) contains the value 0x00, thus signaling to the
POWERLINK Managing Node the error reset of the slave. The Address
field (byte 3) again contains the address of the concerned device.

Example: Error Entry for new ("incoming") error/diagnosis of SWD
slave

If an I/O module placed on position 5 in the SmartWire-DT network (i. e.
Address [byte 3] = 0x05) detects an output overload, (i. e. Diagnosis
Code [byte 12] = 0x13), the telegram looks as follows:

Error Error Code |Time Stamp Additional Information
Type
- Message Address Diagnosis Code | Not used Error Flags Not used
Type
Byte 0 | Byte 1 | Byte 2 Byte 3 Byte 4 | Byte 5 | Byte 6 | Byte 7 | Byte 8 | Byte 9 | Byte 10 | Byte 11| Byte 12 Byte 13 | Byte 14 | Byte 15 | Byte 16 | Byte 17 | Byte 18 | Byte 19
0x70 | 0x00 | OxFF 0x05 0xXX | OxXX | 0xXX [ 0xXX 0xXX | OxXX | OxXX 0xXX 0x13 0x00 0x00 0x00 0x00 0x00 0x00 0x00
Table 26: Error Entry for new ("incoming") error/diagnosis of SWD slave
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Example: Error Entry for resolved error/diagnosis of SWD device
(Error Reset)

If the same I/O module reports that the output is not overloaded any longer
(output overload error has been reset), the Error Entry looks as follows:

Error Error Code |Time Stamp Additional Information
Type
- Message Address Diagnosis Code | Not used Error Flags Not used
Type
Byte 0 | Byte 1 | Byte 2 Byte 3 Byte 4 | Byte 5 | Byte 6 | Byte 7 | Byte 8 | Byte 9 | Byte 10 | Byte 11| Byte 12 Byte 13 | Byte 14 | Byte 15 | Byte 16 | Byte 17 | Byte 18 | Byte 19
0x70 | 0x00 | Ox00 0x05 0xXX | OxXX | 0xXX [ 0xXX 0xXX | OxXX | OxXX 0xXX 0x13 0x00 0x00 0x00 0x00 0x00 0x00 0x00

Table 27: Error Entry for resolved error of SWD slave
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10.2.3 SWD bus error and status messages generated by the gateway

In cases of messages issued by the gateway concerning errors or status
changes of the SmartWire-DT network, the Message Type field (byte 2 of
the Error Entry) has the value 0xFF, and the Address field (byte 3 of the
Error Entry) has the value 0x00.

The nature of the error/status change is specified in the Error Flags (bytes
15 and 16) of the Error Entry (the Diagnosis Code field [byte 12] is not
used in this case).

The following Error Flags are currently defined:

Byte

Entry)

(of Error e

Bit [Hex |Relevanc |Meaning

15

0x01 | Error SWD: Necessary SmartWire-DT slave is missing

0x02 [Warning [SWD: Optional SmartWire-DT slave is missing
0x04 |- -
0x08 |- -
0x10 |- -
0x20 |- -
0x40 |- -
0x80 |- -

16

0x01 |- -
0x02 |- -
0x04 |- -
0x08 |- -
0x10 |Info SWD: The use of compatible slaves is allowed

0x20 [Info SWD: All slaves are registered as “optional”
0x40 |- -
7 |0x80 |- -

||l |WIN|2|OIN|O|O|RA|WIN]|~|O

Table 28: Error Flags in case of bus error/status messages generated by the gateway

@

Important:

Please note that resolved SWD bus errors (unlike error messages
coming from individual SWD slaves) will not be signaled by the
value 0x00 in the Message Type field (byte 2 of the Error Entry),
the Message Type field value will anyway remain at value 0xFF.
This means that in cases of resolved bus errors — as in cases of
“incoming” bus errors — the Message Type field value (byte 2 of the
Error Entry) remains at 0OxFF and the Address field value (byte 3
of the Error Entry) remains at 0x00. Whether the error has been
resolved or not, can be recognized only by checking whether the
corresponding error flag has disappeared.
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Example: Error Entry for new ("incoming") error of SWD bus

If a mandatory SmartWire-DT slave is missing, the Error Entry looks as

follows:

Error Error Code |Time Stamp Additional Information

Type

- Message Address | - Diagnosis Code | Not used Error Flags Not used

Type

Byte 0 | Byte 1 | Byte 2 Byte 3 Byte 4 | Byte 5 [ Byte 6 | Byte 7 | Byte 8 | Byte 9 | Byte 10 | Byte 11 | Byte 12 Byte 13 | Byte 14 | Byte 15 | Byte 16 | Byte 17 | Byte 18 | Byte 19

0x70 | 0x00 | OxFF 0x00 0xXX | OxXX | 0xXX [ 0xXX 0xXX | OxXX | OxXX 0xXX 0x00 0x00 0x00 0x01 0x00 0x00 0x00 0x00
Table 29: Error Entry for incoming error on SWD bus
Example: Error Entry for resolved SWD bus error (Error Reset)
If the gateway reports that the mandatory SmartWire-DT slave is not
missing any longer (i. e. device has returned on the bus), the Error Entry
looks as follows:

Error Error Code |Time Stamp Additional Information

Type

- Message Address | - Diagnosis Code | Not used Error Flags Not used

Type

Byte 0 | Byte 1 | Byte 2 Byte 3 Byte 4 | Byte 5 | Byte 6 | Byte 7 | Byte 8 | Byte 9 | Byte 10 | Byte 11| Byte 12 Byte 13 | Byte 14 | Byte 15 | Byte 16 | Byte 17 | Byte 18 | Byte 19

0x70 | 0x00 | OxFF 0x00 0xXX | OxXX | 0xXX [ 0xXX 0xXX | OxXX [ 0xXX 0xXX 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00
Table 30: Error Entry in case of resolved SWD bus error
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11 Updating firmware

11.1 Overview

The EU5C-SWD-POWERLINK Gateway is shipped with its most recent
firmware already loaded. The version of the loaded firmware is stated on
the device type label.

The integrated web server of the gateway provides a function to update the
firmware of the gateway by HTTP via its Ethernet interface. All you need is
a PC with an ordinary web browser connected to the gateway via Ethernet.
When you perform a firmware update, the old firmware file in the gateway
will automatically be overwritten. The project configuration and the target
configuration in the gateway remain untouched by the firmware update.

Hazard of device damage by disruption of voltagesupply during
firmware update!

Do not interrupt the voltage supply while updating the firmware of the
gateway. Power failure during a writing process in the file system can
cause severe malfunctioning of the device.

9 Note:

. In case of a missing or defective firmware (which is indicated by a
green POW LED), the “regular” firmware update process described
in this chapter is not working. In this case, proceed as described in
chapter Firmware recovery via HTTP [ page 70].
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11.2 IP Address of gateway

In order to connect to the WebServer, you need to know the IP address of
the gateway. On shipment, the default IP address of the gateway is 0.0.0.0.
On commissioning, the gateway receives its IP address with the project
configuration which you have created and downloaded to the gateway by
using the SWD-Assist software. POWERLINK uses the |IP address
192.168.100.x, appended by the individual Node ID (x) of the device. Thus,
if you have defined Node ID 10 in the project configuration of the gateway,
the gateway will have the IP address 192.168.100.10 after downloading the
project configuration to the device.

Using the Ethernet Device Configuration Tool

Apart from POWERLINK, you can assign a temporary IP-address to the
gateway by using the Hilscher Ethernet Device Configuration Tool and
the netIDENT protocol. This temporary IP address is stored volatile in the
gateway and is thus lost after power-off at the device.

You can install this tool on your configuration PC by choosing the Install
Planning and Configuration Toolsoption in the menu of the start screen
of the product DVD, and then selecting the Ethernet Device Scanner/
Configuration Tool option in the opening SmartWire-DT Installation
Wizard (as an alternative, you can also double-click the
EnDevConfigTool.msi file in the Setups and Drivers\EnDeviceCfg folder).

For information about how to use this tool, please refer to the operating
instruction manual Ethernet Device Configuration, which is stored on the
product DVD in the Documentation\english\1.Software\Ethernet Device
Setup Utility directory.

9 Note:

. Before you can use the Ethernet Device Configuration Tool to
assign a temporary IP address, you first have to perform a special
reset operation on the gateway, in order to deactivate the
POWERLINK connection. For this special reset, you must briefly
disconnect the gateway from the voltage supply and keep the
configuration button pushed in for two to three seconds while
reconnecting the voltage supply. The BS and BE LEDs will
automatically turn off after successful reset (for the positions of the
configuration button and the LEDs on the gateway, see section
Device picture [ page 27]).

After having set the temporary IP address and having updated the
firmware in the gateway via web browser and WebServer, you must
perform an ordinary reset of the gateway.
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11.3 Prerequisites

The gateway is connected to a power supply.
The gateway is connected to an IP network via its Ethernet interface.
PC with web browser connected to the IP network.

The IP address of the gateway is compatible to the Ethernet subnet of
the PC.

You know the IP address of the gateway.

9 Note:
. The current version of the firmware does not provide options to

customize the user authentication of the web server by creating own
groups, users or passwords.

11.4 Step-by-step instructions for updating firmware

1. Open web page for firmware update.
» Start the web browser on your configuration PC.
» In the address bar of your browser, enter the URL of the gateway:

http://<IP address>

2 The home page of the WebServer opens.
» In the navigation header of the web page, click FirmwareUpdate.

9 Note:
. You can also open the firmware update page by entering the

IP address
http://<IP address>/fwupdate in the address bar of your browser.

2 The following web page opens:

Firmware Identification

Channel Name Version Date
0 SmartWire-DT POWERLINK 1.0.9.0 28.8.2013

Firmware Update

Choose the new firmware file (.nxf) you want to install:

Browse...

Submit your file by clicking on "transfer”. The transfer will take a few seconds.

WARNING: Do not interrupt power or disconnect cable from the system while the transfer is in progress!

[ Transfer H Cancel I

Figure 20: Firmware update via HTTP (as depicted in Internet Explorer)
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The Firmware Identification section displays the following parameters of
the firmware currently loaded in the gateway:

e Channel: Location (port) of firmware

¢ Name: Name of loaded firmware

e Version: Version of loaded firmware

e Date: Date of creation of loaded firmware

The Firmware Update section features the following control elements:

Control element Function

Browse... Opens the file selection dialog

Transfer Uploads selected firmware file to the device
Cancel Cancels firmware update

Table 31: Controls in Firmware Update Page

. Select new firmware file.

» Click Browse... button, to open a dialog window for selecting the
firmware file.

» Navigate to the directory in which the firmware file is stored, select the
file, and then click Open.

9 Note:
. The name of the firmware file for the EU5C-SWD-POWERLINK
gateway is E030K0OUO.nxf

2 Path and name of the selected file are displayed in the field next to the
Browse... button.

. Download firmware file to gateway.

Hazard of device damage by disruption of voltage supply during
firmware update!

Do not interrupt the voltage supply while updating the firmware of the
gateway. Power failure during a writing process in the file system can
cause severe malfunctioning of the device.

» Click Transfer button to download the new firmware file to the gateway.

2 After you have started the upload by clicking the Transfer button, the
validity of the firmware file is being checked by the system. If the file
fails the validity check, the file will not be stored in the gateway and an
error message will be displayed. If the file passes, the old firmware file
in the gateway is overwritten by the new firmware. Afterwards, the
WebServer requests a reset, in order to start the new firmware.
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11.5 Resetting gateway

After firmware download, you must reset the gateway in order to start the
new firmware. If you have assigned a temporary IP address to the gateway
with the Ethernet Device Configuration Tool, please note that the gateway
loses this address after reset. The gateway then can be reached again
under the IP address defined in the project configuration. If no project
configuration is present in the device, the gateway falls back to its default
IP address 0.0.0.0.

To reset the device, proceed as follows:

1. Open web page for reset.
» In the navigation header of the web page, click Reset.

9 Note:
. You can also open the reset page by entering the IP address http://
<|P address>/reset in the address bar of your browser.

2 The following web page opens:

Device Reset

Initiating a device reset will cause the device to reboot. A reboot will let the device stopping all communications
immediately. Established connections will drop.

Before you initiate a reset make sure that your system is in idle state and operated under maintenance condition in order
to prevent system damages.

Device parameters that have not been saved non-volatile such as a temporary IP address are getting lost during the reset.

Please confirm you want to reset the device.

Figure 21: Reset via HTTP (as depicted in Internet Explorer)

0 Important:
Please note the following consequences of a reset:

The firmware is being restarted and connections will be interrupted
or timed out.

I/0 bus communication is being stopped.

A temporary IP address assigned by the Ethernet Device
Configuration Tool will be lost.

2. Perform reset.

» Activate the checkbox in front of Please confirm... to acknowledge that
you want to reset the device.

9 Note:
. You can use the Cancel button to uncheck the checkbox in front of
Please confirm...

> Click Submit button to start the reset.
= The device is reset.
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12 Firmware recovery via HTTP

12.1 Overview

If the POW system status LED of the gateway shows steady green light,
the “regular” firmware of the gateway is defective or missing (for the
position of the POW LED see section Positions of the LEDs [ page 28]).

In this case only the so-called “backup firmware” is running and the device
is not able to perform its normal gateway functions. This state can be
resolved by downloading a fresh (i. e. uncorrupted) firmware file into the
gateway via HTTP protocol. The backup firmware (which is part of the boot
strap loader running in the gateway) carries a “web server” functionality for
downloading a firmware file comfortably via its Ethernet interface.

For this, you just have to connect the gateway via its Ethernet interface to
an active DHCP server and a configuration PC. The purpose of the DHCP
server is to assign an IP address to the gateway. This assigned IP address
can then be used by the configuration PC to connect to the download
function of the backup firmware running in the gateway, in order to
download the new firmware file via ordinary web browser.

If you do not know the exact IP address assigned to the gateway by the
DHCP server, you can use the Hilscher Ethernet Device Configuration
Tool on your configuration PC (included on the product DVD) in order to
“read out” the newly assigned IP address from the gateway. (The tool uses
the netIDENT protocol to search for all Hilscher devices within the
connected IP network, and then lists all found devices and their IP
addresses.)

9 Note:

. This chapter describes only how to download the recovery firmware.
Instructions on how to configure and operate a DHCP server are not
subject of this manual. For information on using a DHCP server,
please consult your local network administrator.

12.2 Prerequisites

e The gateway is supplied with voltage and the backup firmware inside
the device is running (this is indicated by steady green light at the POW
LED)

e The gateway is disconnected from the POWERLINK network

e The gateway is connected to an active DHCP server via local Ethernet
network

e The gateway is connected via local Ethernet network to a configuration
PC with installed standard web browser
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You have access to the firmware file which you want to download to the
gateway (the firmware file is stored on the SmartWire-DT Gateway
Solutions product DVD in the Firmware\EU5C-SWD-POWERLINK
\Vx.x.x.x folder.

You know the IP address, which the DHCP server has assigned to the
gateway. If not, install the Hilscher Ethernet Device Configuration
Tool on your configuration PC. This tool allows you to check the current
IP address of the gateway (if the configuration PC and the gateway are
connected to the same local Ethernet network). An installer for this
program can be found on the product DVD in the Software
\EnDeviceCfqg folder (the program can also be installed by using the
menu of the product DVD.)

12.3 Step-by-step instructions

1. Use DHCP server to assign IP address to gateway.

>
>

>

Disconnect the gateway from the voltage supply.

Plug a cable connected to the local Ethernet network (in which a DHCP
server is active) into one of the Ethernet RJ45 sockets (labeled LAN1-
IN or LAN2-OUT) on the front side of the gateway.

Reconnect the gateway to the voltage supply.

9 Note:
. The L/A LINK/Activity LEDs of the Ethernet RJ45 sockets remain

dark when an Ethernet cable is plugged-in while the backup
firmware is running — even if a successful IP communication with an
local Ethernet network has been established.

2 The backup firmware running in the device now sends a so-called

DHCPDISCOVER message broadcast into the Ethernet network,
requesting an IP address from a DHCP server. If a DHCP service is
available in the network, the gateway should be receiving a valid IP
address from the server within a few seconds.

2. Check IP address.
» In the Windows Start menu of your configuration PC, select All

Programs > Hilscher GmbH > Ethernet Device Configuration, to
start the Ethernet Device Configuration Tool.
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 The Ethernet Device Configuration tool opens:

& Ethernet Device Configuration E]\ = \@
File Options 2

Devices Online Find: next previous

MAC Address l Device Type | Device Name | IP Address | Protocol l Device ID | Vendor ID | Device role

Search Devices

Figure 22: Ethernet Device Configuration Tool

» Click Search Devices button, to start searching for the gateway within
the local Ethernet network.

2 The tool starts scanning for devices and lists all found Hilscher devices
and their IP addresses:

';; Ethernet Device Configuration EI = ‘@
Datei Optionen 2
Devices Online Find: | next previous
MAC Address | Device Type I Device Name I IP Address [ Protocol l Device ID Vendor ID | Device role
00-02-A2-2D-53-98  Backup FW Backup FW [SN=00020001, ID=0x...  10.11.5.24 Netldent - - -

1

Search Devices

Figure 23: Found gateway in Ethernet Device Configuration Tool

> Note or write down the IP address.

Note:

If the default IP address 0.0.0.0 is displayed, the gateway has not
yet received an IP address from a DHCP server. Make sure that the
gateway is connected to a subnet with an active DHCP server.
Then restart the gateway by briefly disconnecting the voltage supply
while the Ethernet cable remains plugged-in. Wait a few seconds
after reconnecting the voltage supply, then click the Search
Devices button in the Ethernet Device Configuration Tool again.

3. Open web page for firmware download.
» Start the web browser on your configuration PC.

» In the address bar of your browser, enter the IP address of the gateway:
http://<IP address>
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2 The Firmware Update page opens:

()| @ ntpn011526

@ Backup FW - Firmware Upd...

Firmware

Firmware Identification

Channel Name Version Date
0 Backup FW 1.0.1.0 18.4.2011

Firmware Update

Choose the new firmware file (.nxf) you want to install:
Browse...

Submit your file by clicking on "transfer”. The transfer will take a few seconds.

WARNING: Do not interrupt power or disconnect cable from the system while the transfer is in progress!

Transfer || Cancel

Figure 24: Firmware recovery via HTTP (as depicted in Internet Explorer)

4. Select firmware file for download.

» Click Browse... button, to open a dialog window for selecting the
firmware file you want to download.

» Navigate to the directory in which the firmware file is stored, select the
file, then click Open.

9 Note:
. The name of the firmware file for the EU5C-SWD-POWERLINK
gateway is EO30KOUOQ.nxf

2 Path and name of the selected file are displayed in the field next to the
Browse... button.

5. Download firmware file to gateway.
» Click Transfer button to download the new firmware file to the gateway.
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2> After you have started the download by clicking the Transfer button, the
validity of the firmware file is being checked by the system. If the file
fails the validity check, an error message will be displayed. If the file
passes, the gateway requests you to perform a reset in order to start
the new firmware:

()| @ http://1011.5.28

@ Backup FW - Firmware Upd..

Firmware

Transfer succeeded!

You should reset the device to apply the changes.

Firmware is being restarted and connections may be interrupted or time out!

Ethernet connection may be lost if IP parameters are not stored permanently!

VI Please confirm you want to reset the device.

Figure 25: Reset after firmware download via HTTP (as depicted in Internet Explorer)

6. Perform reset.

» Activate the checkbox in front of Please confirm... to acknowledge that
you want to reset the gateway.

9 Note:
. You can use the Cancel button to uncheck the checkbox in front of
Please confirm...

» Click Submit button to start the reset.
2 After successful reset, the following message is displayed:

~ o5
{l’“w\@ http://10.11.5.24/reset p-2c| &y vy
© Backup W - DeviceReset % | |

Device Reset

The device was reset successfully.

All connections are closed. You should be able to reconnect in a few seconds.

Figure 26: Successful device reset message (as depicted in Internet Explorer)

= The POW system status LED at the gateway shows steady yellow light.
The new firmware has been loaded and the gateway is ready for
operation.
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13 Technical data

13.1 Technical data EU5C-SWD-POWERLINK gateway

Category Parameter Value
General Part number 9233.920
Dimensions 35x90 x 127 mm
(W x HxD)
Weight 160 g
Mounting Top hat rail 35 mm (IEC/EN 60715)
Mounting position Vertical
Standards IEC/EN 61131-2
Communication controller netX 50 processor
Configuration and diagnostic interface | Mini-USB
Integrated memory 8 MB SDRAM
4 MB serial Flash EPROM
Ambient mechanical Protection type P20
conditions (IEC/EN 60529, EN50178, VBG 4)
Vibrations Constant amplitude 3.5 mm: 5 -9 Hz
(IEC/EN 61131-2:2008) Constant acceleration 1 g: 9 — 150 Hz
Mechanical shock resistance Semi-sinusoidal 15 g/11 ms: 9 Shocks
(IEC/EN 60068-2-27)
Drop to Drop height: 50 mm
(IEC/EN 60068-2-31)
Free fall, packaged Drop height: 1 m
(IEC/EN 60068-2-32)
Ambient climatic conditions | Operating ambient temperature -25...+55 °C
(IEC 60068-2)
Condensation Prevent by suitable measures
Storage -40...+70 °C

Relative humidity, non-condensing 5..95%
(IEC/EN 60068-2-30)

Electromagnetic Pollution degree 2
compatibility (EMC)

Electrostatic discharge Air discharge (Level 3): 8 kV
(IEC/EN 61131-2:2008) Contact discharge (Level 2): 4 kV
Electromagnetic fields 80 — 1000 MHz: 10 V/m
(IEC/EN 61131-2:2008) 1.4 -2 GHz: 3V/m
2-2.7 GHz: 1V/im
Radio interference suppression EN 55011 Class A
(SmartWire-DT)
Burst Supply cables: 2 kV
(IEC/EN 61131-2:2008, Level 3) POWERLINK bus cable: 1 kV
SmartWire-DT cables: 1 kV
Surge Supply cables: 0.5 kV
(IEC/EN 61131-2:2008, Level 1) POWERLINK bus cable: 1 kV
Radiated RFI 0.15-80 MHz, 10 V, 80% AM / 1 KHz

(IEC/EN 61131-2:2008, Level 3)
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Category Parameter Value
Supply voltage U,x Rated operational voltage 24V DC
-15 % +20 %
Input voltage residual ripple <5%
Protection against polarity reversal Yes
max. current |, 3A

Note: If contactors with a total power consumption >
3 A are connected, a power feeder module EU5C-
SWD-PF1/2 has to be used.

Short-circuit strength

No, external fuse FAZ Z3

Heat dissipation

Typ. 1TW

Potential isolation

No

Rated operating voltage of 24-V-DC
slaves

Typical Upyx-0,2 V

Supply voltage Upqy

Supply voltage 24V DC

-15 % +20 %
Input voltage residual ripple <5%
Protection against polarity reversal Yes

Rated operational current |

111 mA (with two participants)

Heat dissipation at 24 V DC

2.66 W (with two participants)

Potential isolation between Ug,,, and |No

15-V-SmartWire-DT supply voltage

Bridging voltage dips 10 ms

Repeat rate 1s

Status display POW LED
SmartWire-DT supply Rated operational voltage U, 15V+3%
voltage max. current |, 0.7A

Note: If contactors with a total power consumption >
0.7 A are connected, a power feeder module EU5C-
SWD-PF2 has to be used.

Short-circuit strength

Yes

Connection supply
voltages

Connection type

Push-in terminals

solid

0.2 — 1.5 mm? (AWG 24 — 16)

Flexible with ferrule

0.25-1.5mm?

SmartWire-DT network

Participant type

SmartWire-DT master

SmartWire-DT Master ASIC

SWD-80P-RS485

Number of SmartWire-DT slaves 99
Baud rate 125/ 250 kBd
Address setting Automatic
Status display SmartWire-DT master: SWD LED, duo color red/
green
Configuration: Config LED, duo color red/green
Connections Plug, 8-pole

Plug connectors

Blade terminal SWD4-8MF2
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Category Parameter Value
Ethernet POWERLINK Function of gateway POWERLINK Controlled Node (Slave)
network Baud rate 100 MBit/s

Interface type 100 BASE-TX

Half duplex/full duplex Supported

Auto-Negotiation Supported

Auto-Crossover Supported

Address setting By project configuration

Status display POWERLINK Controlled Node: APL, BS, BE LEDs,
duo color red/green

Connector socket 2 x RJ45

Connector plug RJ45

Potential isolation Yes

Table 32: Technical data EU5C-SWD-POWERLINK gateway
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13.2 POWERLINK

Parameter Description

Maximum number of cyclic 1490 bytes

input data

Maximum number of cyclic 1490 bytes

output data

Acyclic data transfer SDO Upload/Download
Functions SDO over ASND and UDP
Baud rate 100 MBit/s, half-duplex
Data transport layer Ethernet Il, IEEE 802.3
Ethernet POWERLINK version |V 2

Limitation No slave to slave communication
Reference to firmware/stack V2.1.x.x

version

Table 33: Technical Data POWERLINK Controlled Node (Slave) Protocol
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